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User’s Manual
Thank you for buying a Samsung Camera.

This manual will guide you through using the camera and
MP3 player, including capturing images,

downloading images, playing music and using the application software.
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Instructions
■ Use this camera in the following order

Insert the 
USB cable

Set up the 
camera driver

Before connecting the camera to a PC, via the USB
cable, you will need to set up the camera driver.
Install the camera driver that is contained in
Application software CD-ROM. (p.127)

Take a picture. (p.23)

Insert the supplied USB cable into the PC’s USB
port and the camera’s USB connection terminal.
(p.136)

Check the camera’s power. If the power is turned off,
press the camera button to turn it on. (p.30)

Take a picture

Check the 
camera’s power

Check 
[Removable Disk]

Open Window’s EXPLORER and search for
[Removable Disk]. (p.137)

● If you use a card reader to copy the images on the memory card to your PC, the images
could be damaged. When transferring the images taken with the camera to your PC, be sure
to use the supplied USB cable to connect the camera to your PC. Please note that the
manufacturer holds no responsibility for loss or damage of images on the memory card due
to the use of a card reader.
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Getting to know your camera
Thank you for buying a Samsung Digital Camera.
● Prior to using this camera, please read the user manual thoroughly.
● When you require After Sales service, please bring the camera and the cause of the camera

malfunction (such as battery, Memory card etc.) to the A/S centre.
● Please check that the camera is operating properly prior to when you intend to use it 

(e.g. for a trip or an important event) to avoid disappointment. Samsung camera takes no
responsibility for any loss or damages that may result from camera malfunction.

● Keep the manual in a safe place.
Ҭ Microsoft, Windows and Windows logo are registered trademarks of Microsoft Corporation

incorporated in the United States and/or other countries.
Ҭ All brand and product names appearing in this manual are registered trademarks of their

respective companies.

DANGER
DANGER indicates an imminently hazardous situation which, if not avoided,
will result in death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation, which, if not avoided,
could result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation, which, if not avoided,
may result in a minor or moderate injury.

Correct Disposal of This Product (Waste Electrical & Electronic Equipment)
(Applicable in the European Union and other European countries with separate
collection systems) This marking shown on the product or its literature, indicates that
it should not be disposed with other household wastes at the end of its working life. 
To prevent possible harm to the environment or human health from uncontrolled

waste disposal, please separate this from other types of wastes and recycle it responsibly to
promote the sustainable reuse of material resources. Household users should contact either the
retailer where they purchased this product, or their local government office, for details of where
and how they can take this item for environmentally safe recycling. Business users should
contact their supplier and check the terms and conditions of the purchase contract. 
This product should not be mixed with other commercial wastes for disposal.

This manual contains instructions on using this camera that will help you to use this
camera safely and correctly. This will help prevent danger and injury to others.
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Danger
■ Do not attempt to modify this camera in any way. This may result in fire, injury, electric shock

or severe damage to you or your camera. Internal inspection, maintenance and repairs
should be carried out by your dealer or Samsung Camera Service centre.

■ Please do not use this product in close proximity to flammable or explosive gases, as this
could increase the risk of explosion.

■ Should any form of liquid or a foreign object enter the camera, do not use it. Switch off the
camera, and then disconnect the power source. You must contact your dealer or Samsung
Camera Service centre. Do not continue to use the camera as this may cause a fire or
electric shock.

■ Do not insert or drop metallic or inflammable foreign objects into the camera through access
points e.g. the memory card slot and battery chamber. This may cause a fire or electric
shock.

■ Do not operate this camera with wet hands. This could pose a risk of electric shock.

■ Do not use the flash in close proximity to people or animals. Positioning the flash too close to
your subject’s eyes, may cause eyesight damage.

■ For safety reasons keep this product and accessories out of reach of children or animals to
prevent accidents e.g.:
•Swallowing battery or small camera accessories. If an accident should occur, please

consult a doctor immediately.
•There is the possibility of injury from the camera’s moving parts.

■ battery and camera may become hot during prolonged use and it may result in camera
malfunction.  Should this be the case, allow the camera to sit idle for a few minutes to allow it
time to cool.

■ Do not leave this camera in places subject to extremely high temperatures, such as a sealed
vehicle, direct sunlight or other places of extreme variances in temperature. Exposure to
extreme temperatures may adversely affect the camera’s internal components and could
cause a fire.

■ When in use, do not cover the camera or AC Charger. This may cause heat to build up and
distort the camera body or cause a fire. Always use the camera and its accessories in a well-
ventilated area.

Warning
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Caution
■ Leaking, overheating, or burst battery could result in fire or injury.

•Use battery with the correct specification for the camera.
•Do not short circuit, heat or dispose of battery in fire.
•Do not insert the battery with the reverse polarities. 

■ Remove the battery when not planning to use the camera for a long period of time. 
Battery may leak corrosive electrolyte and permanently damage the camera’s components.

■ Do not fire the flash while it is in contact with hands or objects. Do not touch the flash after
using it continuously. It may cause burns.

■ Do not move the camera while it is switched on, if you are using the AC Charger. 
After use, always switch off the camera before unplugging the cable from the wall socket.
Then make sure that any connector cords or cables to other devices are disconnected before
moving the camera. Failure to do so may damage the cords or cables and cause a fire or
electric shock.

■ Take care not to touch the lens and where the lens cover is to avoid taking an unclear image
and possibly causing camera malfunction.

■ Avoid obstructing the lens or the flash when you capture an image.

An FCC warning

•This device has been tested in accordance with the limits of a class B digital device
under item 15 of the FCC rules. These limits are designed to provide protection
against harmful interference in commercial installation. This equipment generates,
absorbs and can emit radio frequency energy. If it is not installed and used in
accordance with the instructions, it may cause harmful interference to radio
communication. There is however, no guarantee that interference will not occur in
some situations. Should any interference occur when this device is in operation,
please try one or more of the following measures. 

■ Change the location and direction of any aerial.
■ Increase distance between the camera and the affected device.
■ Use a different socket away from the affected device.
■ Please contact a Samsung agent or a radio/TV engineer.

•This device complies with part 15 of the FCC Rules.
•Changes or modifications not expressly approved by the party responsible for

compliance could void the users authority to operate the equipment. 
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System chart
Please check that you have the correct contents before using this product. The contents can
vary depending on the sales region. To buy the optional equipment, contact your nearest
Samsung dealer or Samsung service centre.

Software CD 
(see p.125, 126)

Camera strap
User manual, 

Product warranty
Camera case

SD memory card/MMC
(see p.18)

DPOF compatible
printer (see p.84)

Rechargeable battery
(SLB-0737)

Cradle SAC-41AC cord

< Included items > 
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System chart

PictBridge compatible
printer(see p.89)

Computer 

External monitor 
Yellow colour - Video
White colour - Voice

(see p.101)

For Windows

•Windows 98/ 98SE/ 2000/ ME/ XP
•PC with processor better than Pentium II

450MHz  (Pentium 700MHz or better is
recommended)

•200MB of available hard-disk space 
(Over 1GB is recommended)

•Minimum 64MB RAM (XP : 128MB)
•1024x768 pixels, 16-bit colour display

compatible monitor (24-bit colour display
recommended)

•DirectX 9.0 or later
•USB port
•CD-ROM drive

For Macintosh

•Power Mac G3 or later
•Mac OS 9.2 ~ 10.3
•Minimum 64MB RAM
•110MB of available hard-disk space
•USB port
•CD-ROM drive

System Requirements

When you connect the camera to a
computer, printer or external monitor, you
have to use the USB/ AV cable supplied
with the camera, or the external devices
can't recognise the camera.

CAUTION

Earphones USB cable for
recharging the battery

USB cable AV cable
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Identification of features

Front & Top

Back & Bottom

※ Take care not to press the lens, lens cover and camera by force. This may cause the camera
malfunction.

Power button

Flash

Optical 3X zoom lens/
Lens cover

SF mode button/
Hold button

Speaker

Microphone

Shutter button

Self-timer lamp/
Auto Focus lamp

LCD monitor

M(Mode/Album) button

Play mode button

Earphones Jack

Zoom T button
(Digital zoom, Vol. Up)

5 function button

+/-, DELETE buttonDC/USB/AV connection terminal
Cradle connector

Camera status
lamp

Zoom W button
(Thumbnail, Vol. Down)

Strap eyelet
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Identification of features

■ You can recharge your rechargeable battery, transfer a captured image to print, and
download images with the cradle. (Refer to page 14, 89 and 136)

FLASH/
LEFT button

MENU/ OK
button

Macro/ DOWN button
Play & Pause button

SELF-TIMER/
RIGHT button

Voice memo/ UP button

Bottom / 5-function button

Cradle

Battery holder

Memory card slot

Battery chamber

Battery chamber cover

● Back

● Top

Camera
connection

terminal

USB port
AV connection
terminal

DC connection
terminal
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Identification of features

■ Mode icon : Refer to page 39, 40 for more information about the camera mode setting. 

■ Self-timer lamp

Icon Status Description

Blinking For the 2 seconds, the lamp blinks quickly at 0.25-second intervals.

For the first 8 seconds, the lamp blinks at 1 second intervals.

For the final 2 seconds, the lamp blinks quickly at 0.25-second 

intervals.

A picture will be taken after about 10 seconds and 2 seconds later a

second picture will be taken.

■ Camera Status Lamp

Status Description

The lamp turns on and off when the camera is ready to

take a picture

The lamp blinks while saving the image data and turns

off when the camera is ready to take a picture

The lamp lights up (LCD monitor turns off after initializing

the device)

Transmitting Data with a PC The lamp blinks (LCD monitor turns off)

When the printer is printing The lamp blinks

Blinking

Blinking

Power on

After taking a picture

When the USB cable is inserted to
a PC

When the USB cable is inserted to
a printer

The lamp lights up

MODE VOICE RECORDING MP3 MOVIE AUTO MANUAL SF PLAY

Icon

NIGHT PORTRAIT CHILDREN LANDSCAPE CLOSE UP TEXT

Icon

MODE SUNSET DAWN BACKLIGHT FIREWORKS BEACH&SNOW -

Icon -

MODE
SCENE
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Connecting to a Power Source

Important information about battery usage
● When the camera is not used, turn off the camera power.
● Please remove the battery if the camera will not be used for long periods. 

Battery can lose power over time and are prone to leaking if kept inside the camera.
● Low temperatures (below 0˚C) can affect the performance of the battery and you may

experience reduced battery life.
● Battery will usually recover at normal temperatures.
● During extended use of the camera, the camera body may become warm. 

This is perfectly normal.

INFORMATION

■ You should use the rechargeable battery (SLB-0737) supplied with the camera. 
Be sure to charge the battery before using the camera. 

■ SLB-0737 rechargeable battery Specification 

■ Number of images and battery life

※ These figures are measured under Samsung’s standard conditions and Shooting conditions
and may vary depending on the way of user’s usage. 

Model SLB-0737

Type  Lithium Ion

Capacity 760mAh

Voltage 3.7V

Charging time Approx. 150 MIN (Using the SAC-41)

Still image Movie MP3

Battery life Number of images Recording time Playing time

Approx. 75 MIN Approx. 150 Approx.65 MIN About 240 min.

Using the fully charged battery
Auto mode, 5M image size  
Fine image quality,
Shot to shot interval : 30Sec. 
Changing the zoom position
between the Wide and the Tele
ends every 1 shot. 
Using the flash every two times.

Based on
the

following
shooting

conditions

Using the fully
charged battery
640X480 image size
30fps frame rate

Using the fully
charged battery
LCD Off.
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Connecting to a Power Source

If you have access to a mains supply, using an SAC-41 allows the camera to be used for long
periods of time.
Plug the SAC-41 into the DC connection terminal on the camera or cradle.
Before turning on the camera power with an SAC-41, insert the rechargeable battery that was
charged for over 10 minutes with turning off the camera. 

● Charging with the cradle
1. Insert the rechargeable battery into the battery

chamber.

■ How to charge the rechargeable battery (SLB-0737) with the SAC-41.

Using the SAC-41

● Always turn off the power before taking the SAC-41 out of the mains supply.
● As with all mains powered devices, safety is important. Ensure that neither the camera

nor Charger comes into contact with water or metallic materials.
● Please ensure that you use the SAC-41 with the correct specification for the camera.

Failure to do so may affect your warranty.

DANGER

2. Place the camera correctly in the
cradle. 

3. Put the SAC-41 into your power socket
and DC connection terminal of the cradle.

Charging LED
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Connecting to a Power Source

※ If you connect the SAC-41 to camera without inserting the rechargeable battery, the charging
LED will brink or be off. In this case, insert the battery and connect the SAC-41 again. 

■ Important information about battery (SLB-0737) charging with the SAC-41

● If the charging LED of the SAC-41 does not
turn on or blink after inserting the rechargeable
battery, please check whether the battery are
inserted correctly.

● Please check the battery charging status with
the charging LED of SAC-41.

Charging LED

Charging LED

● Charging with the camera
1. Insert the rechargeable battery into the battery

chamber.

2. Put the SAC-41 into your power socket and
DC connection terminal of the camera.

■ How to charge the rechargeable battery (SLB-0737) with the SAC-41.
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Connecting to a Power Source
■ Charging LED of the SAC-41

Status Using the cradle Direct to the camera

Being Charged Red LED is on Red LED is on

Charging is complete Green LED is on Green LED is on

Charging error Red LED is off or blinking Red LED is off or blinking

● If there is a charging error, please check all the power connections are in place.

● A USB cable for transmitting data can’t be used for charging the rechargeable battery. 

● A USB cable for recharging the battery is optional. 
- When the USB cable is inserted into the connection terminal of the camera, you can charge
the battery and tramsmit data at the same time. 

- When the USB cable is inserted into the DC connection terminal of the cradle, you can
charge the battery. When the USB cable is inserted into the USB port of the cradle, you can
transmit data. 

■ Charging time (When the camera is turned off)

- Using the cradle : About 150MIN
- Using the SAC-41 : About 150MIN
- Using the USB cable: About 150MIN

Important information about the rechargeable battery.
● If you charge the battery with the camera power on, the battery can't charge fully. 

To charge the battery fully, turn the camera off when you charge it. 
● If you insert the fully discharged battery to charge it, do not turn on the camera at the

same time. The camera may not be turned on because of the low battery capacity.
Charge the battery for over 10 minutes to use the camera. 

● Do not use the flash frequently or take a movie clip with the fully discharged battery
charged for a short time. Even if the charger is inserted, the camera power may be turned
off because the rechargeable battery is discharged again.

INFORMATION
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Connecting to a Power Source
Using the battery : If the camera does not turn on after you have inserted battery, please

check whether the battery are inserted with the correct polarity(+/-).

2. Insert the battery taking note of the polarity 
(+ / -).

3. To close the battery chamber cover, push it
until it clicks.

Removing the battery

1. Turn off the camera power. 
Open the battery chamber cover and move the
battery holder aside. The battery will be released.

2. Take out the battery and close the battery
chamber cover.

■There are 4 indicators for battery condition that are displayed on the LCD monitor.

1. Open the battery chamber cover by pushing in
the direction of the arrow.

● When the battery chamber cover is opened, do not press the battery chamber cover by
force. This may cause the battery chamber cover modification or breakage. 

INFORMATION 

Battery status

Battery indicator

The battery is fully
charged

Low battery capacity
(Prepare to recharge or use spare battery)

Low battery capacity
(Prepare to recharge or use spare battery)

Low battery capacity
(Prepare to recharge or use spare battery)
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Instructions on how to use the memory card
● Be sure to format the memory card (see p.97) if you are using a newly purchased memory for

the first time, if it contains data that the camera cannot recognise, or if it contains images
captured with a different camera.

● Turn off the camera power whenever the memory card is being inserted or removed.
● Repeated use of the memory card will eventually reduce the memory card’s performance.

Should this be the case, you will need to purchase a new memory card. 
Wear and tear on the memory card is not covered by the Samsung warranty.

● The memory card is an electronic precision device. 
Do not bend, drop or subject the memory card to any heavy impact.

● Do not store the memory card in an environment with strong electronic or magnetic fields,
e.g. near loud speakers or TV receivers.

● Please do not use or store in an environment where there are extremes in temperature.
● Do not allow the memory card to become dirty or to come into contact with any liquid. 

Should this happen, clean the memory card with a soft cloth.
● Please keep the memory card in its case when not in use.
● During and after periods of extended use, you may notice that the memory card is warm. 

This is perfectly normal.
● Do not use a memory card that is used in another digital camera.

To use the memory card in this camera, format the memory card using this camera. 
● Do not use a memory card formatted by another digital camera or memory card reader.
● If the memory card is subjected to any of the following, the recorded data may become

corrupted :
- When the memory card is used incorrectly.
- If the power is switched off or the memory card is removed while recording, deleting
(formatting) or reading.

● Samsung cannot be held responsible for lost data.
● It is advisable to copy important data onto other media as back-up e.g. floppy disks, hard

disks, CD etc.
● If there is insufficient memory available 

: A [Card Full!] message will appear and the camera will not operate. To optimise the amount
of memory in the camera, replace the memory card or delete unnecessary images stored
on the memory.
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Instructions on how to use the memory card

● Don't remove the memory card when the camera status lamp is blinking as this may
cause damage to data in the memory card.

INFORMATION

[ SD (Secure Digital) memory card ]

Write
protect
switch

Label

Card pins

■ The camera can use SD Memory Cards and MMC (Multi Media Cards). 
Please consult the enclosed manual for using the MMC Cards.

The SD memory card has a write protect switch
that prevents image files from being deleted or
formatted. By sliding the switch to the bottom of
the SD memory card, the data will be protected.
By sliding the switch to the top of the SD
memory card, the data protection will be
cancelled. 
Slide the switch to the top of the SD memory
card before taking a picture.

■ When using a 32MB memory, the specified shooting capacity will be as follows. 
These figures are approximate as image capacities can be affected by variables such as
subject matter and memory card type.

※ The zoom buttons are not pressed during the movie clip recording. 
The recording times can be changed by the zoom operation. 

Recorded image size S. Fine Fine Normal 30FPS 15FPS

5M(2592x1944) 11 21 32 - -

4M(2272x1704) 14 27 40 - -

3M(2048x1536) 17 33 49 - -

2M(1600x1200) 28 52 75 - -

1M(1024x768) 66 111 151 - -

VGA(640x480) 149 217 275 - -

640(640X480) - - - About 2MIN About 4MIN

320(320X240) - - - About 4MIN About 8MIN

160(160X128) - - - About 8MIN About 15MIN

Still
image

* Movie
clip
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Inserting the memory card

3. To close, push the battery chamber cover until you hear
a click. If the memory card does not slide in smoothly,
do not attempt to insert it by force. Check the direction
of insertion, and then insert it correctly. Do not insert the
memory card the wrong way round. Doing so may
damage the memory card slot.

1. Turn the power off using the power button.
Open the battery chamber cover and press the
memory card as shown in the image and release.

2. Remove the memory card and close the battery
chamber cover.

2. Have the front of the memory card facing toward the front
of the camera (lens) and the card pins toward the back of
the camera (LCD monitor), and then push the memory
card into the card slot until you hear a click.

1. Turn off the camera’s power and pull the battery chamber
cover in the direction of the arrow to open.

Removing the memory card

● When the camera is turned on, inserting or removing the memory card turns the camera
power off.

INFORMATION
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When Using the Camera for the First Time
■ Charge the rechargeable battery fully before using the camera for the first time. 

■ When the camera is turned on for the first time, a menu will be displayed to set date, time and
language in the LCD monitor. This menu will not be displayed after setting up the date, time
and language. Set up the date, time and language before using this camera. 

● Setting up the date, time and date type
1. Select the [Date&Time] menu by pressing the UP/DOWN

button and press the RIGHT button.
2. Select the desired sub menu by pressing the 

UP/ DOWN/ LEFT/ RIGHT button.
RIGHT button : selects YEAR/ MONTH/ DAY/ HOUR/

MINUTE/ DATE TYPE
LEFT button : Moves the cursor to the [Date&Time]

main menu if the cursor is at the first item of the date and time setup.
In all other instances, the cursor will be shifted to the left of its current
position.

UP/ DOWN button : changes the value of each item.

● You can select 21 languages. These are listed below : 
English, Korean, French, German, Spanish, Italian, S.Chinese, T.Chinese, Japanese,
Russian, Portuguese, Dutch, Danish, Swedish, Finnish, Thai, 
BAHASA(MALAY/ INDONESIAN), Arabic, Hungarian, Czech and Polish. 

● Even if the camera is restarted, the language setting will be maintained.

INFORMATION

● Setting up the language
1. Select the [Language] menu by pressing the UP/DOWN

button and press the RIGHT button.
2. Select the desired sub menu by pressing the UP/ DOWN

button and press the OK button. 
When the settings are complete, press the MENU button
twice to exit the menu screen.

Date&Time
Language

Setup

Back:◀ Set:OK

▲

05/05/01 13:00
▼

yy/mm/dd

Date&Time
Language

ENGLISH
한국어
FRANÇAIS
DEUTSCH
ESPAÑOL

Setup

Back:◀ Set:OK
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LCD monitor indicator
■ The LCD monitor displays information about the shooting functions and selections.

[Image & Full Status]

No. Description Icons Page

2 Battery p.17

3 Continuous shot p.52

4 Flash p.36

5 Self-timer p.38

6 Macro p.33

7 Metering p.52

8 Card inserted indicator -

9 Auto focus frame -

10 Camera shake warning p.29

11 Date/ Time 2005/05/01   01:00 PM p.98

12 Exposure compensation p.44

13 White Balance p.43

14 ISO p.43

Recording mode1 p.49

①

②

③

④

⑤

⑥

⑦

⑧

⑬

⑫

⑭

⑮

⑰

⑯

⑱

⑲

⑩⑨ ⑪

؊ ⑳
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LCD monitor indicator

Changing the recording mode

■ Selecting the [Mode] menu
1. Insert the battery (p.17). 
2. Insert the memory card (p.20). As this camera has a 48MB internal memory, you do not

need to insert the memory card. If the memory card is not inserted, an image will be stored
in the internal memory. If the memory card is inserted, an image will be stored on the
memory card.

3. Close the battery chamber cover.
4. Press the power button to turn on the camera.
5. Press the menu button and a menu will display. 
6. Use the UP/DOWN button to select the [Mode] menu. 
7. Select [Still/ Movie/ MP3] or [Full] sub menu by pressing the

UP/ DOWN button. 
- [Still/ Movie/ MP3] : A still image mode that was selected

in the [Mode set] menu and movie clip mode can be selected.
Refer to page 49 for more information about using the [Mode set] menu.

- [Full] : Auto, Manual, Voice Recording, Movie clip and scene modes can be selected.
8. Press the MENU button and the menu will disappear. 

■ You can select the desired working mode using the M (Mode) button located on the back of the
camera and then the [Mode], [Mode set] menu. Auto, manual, Voice Recording, movie clip and
scene (night, portrait, children, landscape, text, close-up, sunset, dawn, backlight, fireworks, beach &
snow) camera modes are available. Refer to page 106 for more information about the MP3 mode.

15 RGB RGB p.42

16 Sharpness p.53

17 Image quality/ Frame rate p.51

Number of available shots remaining 38

Remaining time (Movie clip/ Voice recording) 00:01:30/ 01:00:00

20 Voice memo/ Mic. off p.32/26

19

18 p.50

p.19

Image size

Optical/ Digital Zoom bar/ 
Digital Zoom rate

21 p.31

Still/ Movie/ MP3
Full

Mode
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Changing the recording mode
● Changing the recording mode : If the [Still/ Movie/ MP3] menu was selected

Steps from 1-4 are the same as those for selecting the [Mode] menu. 
5. A recording mode used just before will display.
6. Press the M (Mode) button located on the back of the camera and the recording mode will

change to the movie clip mode. 
7. Press the M (Mode) button twice and a still image mode selected on the [Mode set] menu

will be selected.

● Changing the recording mode : If the [Full] menu was selected
Steps from 1-4 are the same as those for selecting the [Mode] menu. 
5. A recording mode used just before will display.
6. Press the M (Mode) button located on the back of the camera and the mode selection

menu will display. 
7. To select the Auto, Manual, Voice Recording, MP3, Movie clip or Scene modes, press the

Left/Right button. To move between the Auto, Manual, Voice Recording, Movie clip menu
line and Scene menu line, press the Up/Down button.

8. Press the M (Mode) button and the mode selection menu will disappear.

Pressing the M (Mode) button

[AUTO mode] [MOVIE CLIP mode]

Pressing the Up button

Night

[Selecting the Scene mode]

Pressing the Left button

[Mode selection menu]

AUTO

Set : OK/M

Movie

[Selecting the Movie clip mode]

Set : OK/M

Set : OK/M
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Starting the recording mode
■ How to use the Auto mode

Use this for shooting basic still images. 
1. Select the [Full] sub menu on the [Mode] menu (p.23). 
2. Select the Auto mode by pressing the M (Mode) button

(p.24).
3. Point the camera towards the subject and compose the

image by using the LCD monitor.
4. Press the shutter button to capture an image.

■ How to use the Movie clip mode
A movie clip can be recorded for as long as the available recording time of the memory
capacity allows. 
1. Select the [Full] sub menu on the [Mode] menu (p.23). 
2. Select the Movie clip mode by pressing the M (Mode)

button (p.24).
3. Point the camera towards the subject and compose the

image by using the LCD monitor.
4. Press the shutter button once and movie clips are

recorded for as long as the available recording time
allows. Movie clips will still be recorded if the shutter
button is released. If you wish to stop recording, press the shutter button again.
※ Image size and type are listed below.

- Image size : 640X480, 320X240, 160X128 (user selectable)
- Movie clip file type : AVI (MPEG-4)

● If the auto focus frame turns to red when you press the shutter button down half way, it
means that the camera cannot focus on the subject. Should this be the case, the camera
is less likely to capture an image clearly.

● Avoid obstructing the lens or the flash when you capture an image.

INFORMATION

[AUTO mode]

[MOVIE CLIP mode]
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Starting the recording mode

■ How to use the Manual mode
Selecting the automatic mode will configure the camera with optimal settings. 
You can still manually configure all functions except the aperture value and shutter speed.
1. Select the [Full] sub menu on the [Mode] menu (p.23). 
2. Select the Manual mode by pressing the M (Mode) button

(p.24).
3. Point the camera towards the subject and compose the

image by using the LCD monitor.
4. Press the shutter button to capture an image.

■ Pausing while recording a movie clip (Successive Recording)
This camera allows you to temporarily stop during unwanted scenes, while recording a movie
clip. Using this function, you can record your favourite scenes into a movie clip without having
to create multiple movie clips.

● Using Successive Recording
Steps from 1-2 are the same as those for MOVIE CLIP
mode.
3. Point the camera towards the subject and compose the

image by using the LCD monitor. Press the shutter
button and movie clips are recorded for as long as the
available recording time. Movie clips will still be recorded
if the shutter button is released.

4. Press the Pause button(                ) to pause recording.
5. Press the Pause button(                ) again to resume the recording.
6. If you wish to stop recording, press the shutter button again.

■ Recording the movie clip without voice
You can record the movie clip without voice.  
Steps from 1-3 are the same as those for MOVIE CLIP
mode. 
4. Press the Up button and the (        ) icon will display on

the LCD monitor. 
5. Press the shutter button and movie clip is recorded for

as long as the available recording time without voice. 
6. To stop the recording, press the shutter button again. 

[MANUAL mode]

[Successive recording of a movie clip]
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Starting the recording mode
■ How to use the Scene modes

Use the menu to easily configure optimal settings for a variety of shooting situations.
1. Select the [Full] sub menu on the [Mode] menu (p.23). 
2. Select the Scene mode by pressing the M (Mode) button

(p.24).
3. Point the camera towards the subject and compose the

image by using the LCD monitor.
4. Press the shutter button to capture an image.

※ The scene modes are listed below.
[Night](        ) : Use this for shooting still images at night or in other dark

conditions.

[Portrait](        ) : To take a picture of a person.

[Children](        ) : To take a picture of fast moving objects, for example, children.

[Landscape](        ) : To take pictures of distant scenery.

[Close up](        ) : Close-up shooting for small objects such as plants and insects.

[Text](        ) : Use this mode to shoot a document.

[Sunset](        ) : For taking pictures of sunsets.

[Dawn](        ) : Daybreak scenes.

[Backlight](        ) : Portrait without shadows caused by backlight.

[Firework](        ) : Firework scenes.

[Beach & Snow](        ) : For ocean, lake, beach and snowscape scenes.

[SCENE mode]
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Starting the recording mode

● A distance of 40cm between you and the camera (microphone) is the best distance to
record sound.

INFORMATION

■ How to use the VOICE RECORDING mode
A voice recording can be recorded for as long as the available recording time of the memory
capacity allows. (Max: 1 hour)
1. Select the [Full] sub menu on the [Mode] menu (p.23).
2. Select the Voice Recording mode by pressing the M

(Mode) button (p.24).
3. Press the shutter button to record a voice.

- Press the shutter button once and voice is recorded for as
long as the available recording time (Max : 1 hour) allows.
The recording time will be displayed on the LCD monitor.
Voice will still be recorded if the shutter button is released.

- If you wish to stop recording, press the shutter button again.
- File type : WAV

■ How to use the SF mode
In poor indoor light conditions, Safety Flash will help you get a good image without the use of
a flash. In every camera mode, the SF mode can be selected. 
1. Press the SF mode button. 
2. Press the shutter button to capture an image.

※ Refer to page 41 for more information about the 
SF function.

[VOICE RECORDING mode]

[SF mode]
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Things to Watch Out for When Taking Pictures
■ Pressing the shutter button down half way 

Lightly press the shutter button to confirm focus and flash battery charge. 
Press the shutter button all way down to take the picture.

■ The available recording time may vary depending on shooting conditions and camera
settings.

■ When the Flash Off or Slow synchro mode is selected in a low lighting condition, the camera
shake warning indicator (         ) may appear on the LCD monitor. In this case, support the
camera on a solid surface or change the flash mode to flash shot mode.

■ Backlight compensated shots : When taking an outdoor shot, avoid facing the sun, as the
image may be dark because of the strong backlight. 
To take a picture against the sun, please use the [Backlight] in
the scene shooting mode (see page 27), Fill-in flash 
(see page 36), Spot metering (see page 52), or Exposure
compensation (see page 44).

■ Avoid obstructing the lens or the flash when you capture an image.
■ Under certain conditions the auto focus system may not perform as expected.

- When photographing a subject that has little contrast.
- If the subject is highly reflective or shiny.
- If the subject is moving at high speed.
- When there is strong reflected light, or when the background is very bright.
- When the subject matter has only horizontal lines or the subject is very narrow 
(such as a stick or flagpole).

- When the surroundings are dark

[ Lightly press the shutter button ] [ Press the shutter button ]
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Using the camera buttons to adjust the camera
■ The recording mode function can be set up by using the camera buttons.

POWER button

SHUTTER button

● If the menu is not displayed, this button works as the
OPTICAL ZOOM or DIGITAL ZOOM button.

● Used for turning the camera’s power on / off.
● If there is no operation during the specified time, the

camera's power will be turned off automatically to save
battery life. Refer to page 96 for more information about the
auto power off function.

● Used for taking an image or recording voice in the
recording mode.

● In MOVIE CLIP mode 
Pressing the shutter button down fully starts the process for
recording a movie clip. Press the shutter button once and
the movie clip is recorded for as long as the available
recording time in the memory allows. If you wish to stop
recording, press the shutter button again.

● In STILL IMAGE mode
Pressing the shutter button down halfway activates the autofocus and checks the condition of
the flash. 
Pressing the shutter down fully takes the image and stores the relevant data regarding the
shot. If you select voice memo recording, the recording will start after the camera has finished
storing the image data.

ZOOM W/ T button
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ZOOM W/ T button
■ This camera has a 3X optical zoom and a 5X digital zoom function. Using both will offer a

total zoom ratio of 15X.

● TELE Zoom
Optical zoom TELE : Pressing the ZOOM T button. This will zoom into the subject i.e.

the subject will appear nearer.
Digital zoom TELE : When the maximum (3X) optical zoom is selected, pressing the

ZOOM T button activates the digital zoom software. Releasing
ZOOM T button stops the digital zoom at the required setting.
Once the maximum digital zoom (5X) is achieved, pressing the
ZOOM T button will have no effect.

[ WIDE zoom ] [ TELE zoom ] [ Digital zoom 5.0X ]

Pressing the
ZOOM T button

Pressing the
ZOOM T button

● WIDE Zoom
Optical zoom WIDE : Pressing the ZOOM W button. This will zoom out from the subject

i.e. the subject will appear further away. Pressing the ZOOM W
button continuously will set the camera to its minimum zoom
setting i.e. the subject appears at its furthest from the camera.

Digital zoom WIDE : When the digital zoom is in operation, pressing the ZOOM W
button will reduce the digital zooming in steps.
Releasing ZOOM W button stops digital zooming.
Pressing the ZOOM W button will reduce the digital zoom and
then it will continue to reduce the optical zoom until the minimum
setting is reached. 

[ TELE zoom ] [ Optical zoom 2X ] [ WIDE zoom ]

Pressing the
ZOOM W button

Pressing the
ZOOM W button

[ Digital zoom 5.0X ] [ TELE zoom ] [ WIDE zoom ]

Pressing the
ZOOM W button

Pressing the
ZOOM W button

Optical zoom

Digital zoom
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ZOOM W/ T button

● Images taken using the digital zoom may take a little longer for the camera to process.
Allow time for this to take place.

● The digital zoom cannot be used in movie clip shots.
● If the Zoom buttons are being pressed during the Movie clip shots, the voice will not

recorded.
● You may notice a decrease in image quality when using the digital zoom.
● To view more clear digital zoom image, press the shutter button halfway at the maximum

(3X) optical zoom position and press the zoom T button again.
● The digital zoom can’t be activated in the [Night], [Children], [Close up], [Text] and

[Fireworks] scene modes.
● Take care not to press the lens, lens cover and camera by force. This may cause the

camera malfunction.

INFORMATION

■ While the menu is showing, press the Up button to move the cursor up the sub menu. 
When the menu is not displayed on the LCD monitor, the Up button operates as the voice
memo (        ) button.

● Recording a voice memo
1. Press the M (Mode) button to select a Recording mode with the exception of Movie clip

mode.
2. Press the Voice memo (       ) button. If the voice memo indicator is displayed on the LCD

monitor, the setting is completed.

Pressing the Voice memo button

Voice memo(      )/ UP button
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Voice memo(     )/ UP button

● A distance of 40cm between you and the camera (microphone) is the best distance to
record sound.

INFORMATION

■ While the menu is showing, press the DOWN button to
move from the main menu to a submenu, or to move down
the submenu cursor. When the menu is not showing, you
can use the MACRO/ DOWN button to take macro pictures.
The distance ranges are shown below. Press the Macro
button until the desired macro mode indicator displays on
the LCD monitor. [Auto focus - No icon]

[Super macro (       )][Auto macro (       )] [Macro (       )]

3. Press the shutter button and take a picture.
The picture is stored on the memory.

4. Voice memo will be recorded for ten seconds from the
moment the picture is stored. In the middle of the voice
recording, pressing the shutter button will stop the voice
memo.

[Recording Voice Memo]

Macro(      )/ Down button
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Macro(     )/ Down button
■ Types of focus modes and focus ranges (W: Wide, T: Tele) (Unit : cm)

● When the macro mode is selected, it is possible that camera shake will occur. 
Take care not to shake the camera.

● When you take a picture within 20cm (Wide zoom) or 30cm (Tele zoom) in the Macro
mode, select the FLASH OFF mode.

● When you take a picture within 5cm, the AF may take a time to get exact focus range. 
● The super macro is executed on the wide zoom position only. 

INFORMATION

※ See the next page for the available focusing method, by recording mode.

Mode

Focus Type Super macro (       ) Auto macro(���) Normal

Mode

Focus Type Super macro(���) Macro(���) Normal

Focus range

Focus range

W : 5~Infinity
T : 50~Infinity

W : 50~Infinity
T : 50~Infinity

W : 50~Infinity
T : 50~Infinity

W : 1~5
(Wide only)

W : 1~5
(Wide only)

W : 5~50
T : 25~50

Manual (�����)

Auto (�����)



《35》

Macro(     )/ Down button
■ Available focusing method, by recording mode ( O: Selectable , X: Not selectable, ∞: Infinity focus range)

Focus lock

■ To focus on the subject positioned outside of the centre, use the focus lock function.

● Using the Focus Lock
1. Ensure the subject in the centre of the autofocus frame.
2. Press the SHUTTER button halfway. When the green auto focus frame lights up, it means

the camera is focused on the subject. Be careful not to press the SHUTTER button all the
way down to avoid taking an unwanted picture.

3. With the SHUTTER button still pressed down only halfway, move the camera to
recompose your picture as desired, and then press the SHUTTER button completely to
take the picture. If you release your finger from the SHUTTER button, the focus lock
function will be cancelled.

1. The image to be captured. 2. Press the SHUTTER
button halfway and
focus on the subject.

3. Recompose the picture
and fully depress the
SHUTTER button.

X O X O

X O O X

O X O X

O O O X

SCENE

Mode

Auto macro

Super macro

macro

Normal

Auto macro

Super macro

macro

Normal

Mode

X X X X X O X X X X X

X X X X X X X X X X X

X X X X O X X X X X X

O O O ∞ X    X    ∞ ∞ O ∞ O
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Flash (     )/ Left button

[Selecting the Auto flash]

● Flash range (Unit : m)

■ When the menu is displayed on the LCD monitor, pressing
the LEFT button makes the cursor shift to the left tab.

■ When the menu is not displayed on the LCD monitor, the
LEFT button operates as the FLASH (        ) button.

● Selecting the flash mode
1. Press the M (Mode) button to select a Recording mode

with the exception of Movie clip mode and the Voice
Recording mode (p.24).

2. Press the Flash button until the desired flash mode indicator displays on the LCD monitor. 
3. A flash mode indicator will be displayed on the LCD monitor. Use the correct flash to suit

the environment.

● When the flash is charging, a flash mode icon (red colour) will blink on the LCD monitor. 
● Using the flash frequently will reduce the life of the battery.
● Under normal operating conditions the charging time for the flash is normally within 

4 seconds. If the battery is weak, the charging time will be longer.
● During the continuous shot and movie clip mode, the flash function will not operate. 
● Take photographs within the flash range.
● The image quality is not guaranteed if the subject is too close or highly reflective.

INFORMATION

Auto Macro Auto macro

WIDE TELE WIDE TELE WIDE TELE

0.5 ~ 2.4  0.5 ~ 1.9 0.2 ~ 0.5 0.3 ~ 0.5 0.2 ~ 2.4 0.5 ~ 1.9

ISO

Auto

※ If the Super macro is selected, the flash is fixed as the Flash Off. 
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Flash (     )/ Left button

Menu tab Flash mode Description 

● Flash mode indicator

If the subject or background is dark, the camera flash will operate
automatically.

Auto flash

Auto &
Red eye
reduction

Fill in flash 

Slow synchro

Flash off

If a subject or background is dark, the camera flash will work
automatically and will reduce the red-eye effect by using the red-
eye reduction function.

The flash will operate in conjunction with a slow shutter speed in
order to obtain the correct exposure. When you take an image in
a condition with poor light, the camera shake warning indicator 
(         ) will display on the LCD monitor.

The flash fires regardless of available light. 
The intensity of the flash will be controlled, according to the
prevailing conditions. The brighter the background or subject is,
the less intense the flash will be.

The flash does not fire. Select this mode when capturing images
in a place or situation where flash photography is prohibited.
When you capture an image in a poorly lit condition, the camera
shake warning indicator (         ) will display on the LCD monitor.

● Available flash mode, by recording mode

X X O X X X X X X X X X X O

X O O X O O X X X X X X X X

X X O X X X X X X X X O X X

X X O O X X X X X X X X X X

O O O O O O O O O O O X O X
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Self-timer (     )/ Right button
■ When the menu is displayed on the LCD monitor, pressing the Right button makes the cursor

shift to the right tab. The right button can also be used to move to a sub menu to select a
different setting. When the menu is not displayed on the LCD monitor, the RIGHT button
operates as the Self-timer. This function is used when the photographer would also like to be
in the image.

● Using the self-timer
1. Press the M (Mode) button to select a still image mode or movie clip mode (p.24). 
2. Press the Self-timer button until the desired mode indicator displays on the LCD monitor. 

In Movie clip mode, only the 10 Sec. self-timer can be used.
- 2 Sec. Self-timer(       ) : Pressing the shutter button will allow an interval of 2 seconds

before the image is taken. 
- 10 Sec. Self-timer(       ) : Pressing the shutter button will allow an interval of 10 seconds

before the image is taken. 
- Double Self-timer(       ) : A picture will be taken after about 10 seconds and 2 seconds

later a second picture will be taken. When using the flash, the 
2-second self-timer may be delayed for longer than 2 seconds
depending on the flash charge time.

3. When you press the Shutter button, the picture will be taken after the specified time has
elapsed.

※ If you operate the Power button and Self-timer button during the self-timer operation, the
self-timer function is cancelled.

Pressing the Self-timer button

[2 Sec. self-timer]

Pressing the Self-timer

[10 Sec. self-timer][Double self-timer]
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MENU/ OK button
■ MENU button

- When you press the MENU button, a menu related to each camera mode will be displayed
on the LCD monitor. Pressing it again will return the LCD to the initial display.

- A menu option can be displayed when the following are selected :
MOVIE CLIP and STILL IMAGE mode. There is no menu available when the VOICE
RECORDING mode is selected.

■ OK button

- When the menu is displayed on the LCD monitor, this button is used for shifting the cursor
to the sub menu or for confirming data.

■ You can turn on the camera with this button. When the camera is turned on by pressing the
M button, the Start image will not display and only the still image mode will be executed. 

■ You can select the desired recording mode.

The selectable recording modes are different from what you selected sub menu in the 
[Mode] menu.
- [Still / Movie / MP3] : Still image modes, Movie clip mode
- [Full] : Auto, Manual, Voice Recording, Movie clip, Scene modes

● How to use the mode button : In case of [Still/ Movie/ MP3] and [Auto] sub menu 

M (Mode) button 

Pressing the MENU button

[Menu off] [Menu on]

[Auto mode] [Movie clip mode]

Pressing the M button

Auto

Manual
Movie
Night

portrait
Children

Mode Set
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Portrait

Set : OK/M

Manual

Set : OK/M

M (Mode) button 
● How to use the mode button : In case of [Full] sub menu and Auto mode

※ Press the Mode button and the mode selection menu will disappear.
※ Refer to page 106 for more information about the MP3 mode. 

Pressing the Up button

Pressing the Right button

Pressing the Left/ Right button

Pressing the Left button

[Auto mode]

[Manual mode]

[Mode selection menu]

[Movie clip mode]

[Scene mode]

Pressing the Mode button

[Selecting a scene mode]

Night

Auto

Set : OK/M

Set : OK/M

Movie

Set : OK/M
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SF button 
■ Pressing the SF button selects the SF(Safety Flash) mode

In poor indoor light conditions, Safety Flash will help you get a good image without the use of
a flash. As children are sensitive of using flash, this is suitable function for taking children. 

● Things to watch out for using the SF mode
1. The SF range is 2m(WIDE) and 1.5m(TELE).
2. The digital zoom will not operate in the SF mode. 
3. If the lighting conditions are brighter than fluorescent lighting condition, the SF doesn’t

activate.
4. If the lighting condition is darker than in fluorescent lighting

condition, camera shake warning indicator (           ) will
display. Take a picture in a place where the camera
shake warning indicator is not displayed and you will get
clear image. 

5. If the subject is moving the final image captured may be
blurred.

6. Avoid moving the camera while the [Capturing!] message
is displayed to achieve a better result.

7. As the SF uses the camera’s digital processor, images
taken using the SF may take a little longer for the camera
to process.

Capturing!
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+/- button
■ You can use the +/- button to adjust the values for the RGB, ISO, white balance, exposure

compensation and Long Time shutter speed.

■ When the SF is selected, ISO value is fixed as AUTO and Exposure value is fixed as 0.0EV.

■ RGB : Allows the user to adjust the R (Red), G (Green), and B (Blue) values of the images to
be captured. 

● Setting RGB Values
1. Press the +/- button, and then use the UP and DOWN

buttons to select the RGB icon (          ). 
The RGB menu bar will appear as shown.

2. Use the UP/ DOWN/ LEFT and RIGHT buttons to select
the desired RGB value.
- Up/ Down Button : Navigates between R, G, and B

icons.
- Left/ Right Button : Changes value of each icon.

3. When you press the +/- button again, the value you set will be saved and RGB setup
mode will end.

Main menu Sub menu Available camera mode

RGB R (Red), G (Green), B (Blue)

ISO AUTO, 100, 200, 400

WHITE BALANCE

Exposure compensation -2.0 ~ 0.0 ~ +2.0 (0.5EV steps)

LT
Shutter speed/ Aperture Value

(Changed by zoom rate)

AUTO, DAYLIGHT, CLOUDY,
FLUORESCENT H, 

FLUORESCENT L, TUNGSTEN,
CUSTOM.
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+/- button

● Selecting an ISO Sensitivity
1. Press the +/- button, and then use the UP and DOWN

buttons to select the ISO icon(          ). The ISO menu bar
will appear as shown.

2. Use the LEFT and RIGHT buttons to select the desired
ISO sensitivity value.
- AUTO : The camera's sensitivity is automatically changed
by variables such as lighting value or subject brightness.

- 100, 200, 400 : You can increase the shutter speed while the same amount of light is
present, by increasing the ISO sensitivity. However, the image may be saturated in high
luminance. The higher the ISO value, the higher the camera’s sensitivity to light is and
therefore the greater its capacity to take pictures in dark conditions. However, the noise level
in the image will increase as the ISO value increases, making the image appear coarse.

3. When you press the +/- button again, the value you set will be saved and ISO setup mode will end.

■ White balance : The white balance control allows you to adjust the colours to appear more
natural looking. 

● Selecting a White Balance
1. Press the +/- button, and then use the UP and DOWN

buttons to select the white balance icon (           ).
The white balance menu bar will appear as shown.

2. Use the LEFT and RIGHT buttons to set the white balance
to the desired value. The value you set will be displayed on
the LCD monitor.
AUTO : The camera automatically selects the

appropriate white balance settings, depending on the prevailing
lighting conditions.

DAYLIGHT : For taking images outside.

CLOUDY : For taking images under a cloudy and overcast sky.

Fluorescent H : For shooting under daylight fluorescent types of three-way
fluorescent lighting.

Fluorescent L : Shooting under white fluorescent lighting.

TUNGSTEN : For shooting under tungsten (standard light bulb) lighting.

CUSTOM : Allows the user to set the white balance according to the shooting
condition.

Different lighting conditions may cause a colour cast on your images.
3. Press the +/- button again. The value you set will be saved and White Balance setup mode

will end.

■ ISO : You can select the ISO sensitivity when taking pictures.
The speed or specific light-sensitivity of a camera is rated by ISO numbers.
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+/- button
● Using the Custom White Balance

White balance settings may vary slightly depending on the shooting environment. 
You can select the most appropriate white balance setting for a given shooting environment
by setting up the custom white balance.

1. Select the CUSTOM (             ) menu of the White
Balance.

2. Place a sheet of white paper in front of the camera so
that the LCD monitor shows only white, and then press
the SHUTTER button.

3. Your custom white balance value is stored.
- The custom white balance value will be applied,
starting with the next picture you take.

- The user configured white balance will be remain
effective until it is overwritten.

[ White paper ]

■ Exposure compensation : This camera automatically adjusts the exposure according to the
ambient lighting conditions. 
You can also select the exposure value by using the +/- button.

● Compensating Exposure
1. Press the +/- button, and then use the UP and DOWN

buttons to select the exposure compensation icon 
(          ). The exposure compensation menu bar will appear
as shown.

2. Use the LEFT and RIGHT buttons to set the desired
exposure compensation factor.

3. Press the +/- button again. The value you set will be saved
and the Exposure Compensation setup mode will close. 
If you change the exposure value, the exposure indicator (          ) will be displayed on the
bottom of the LCD monitor.

※ A negative exposure compensation value reduces the exposure. 
Note that a positive exposure compensation value increases the exposure and the LCD
monitor will appear white or you may not get good pictures.

Measure:Shutter 
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+/- button
■ Long Time shutter : This camera automatically adjusts the shutter speed and aperture values

to the shooting environment. However, in NIGHT SCENE mode, you can
set the shutter speed and aperture values to your preference.

● Adjusting the shutter speed and aperture values
1. Select the [Night] scene mode. 

(M button → [Scene] → [Night])
2. Press +/- button and Long Time shutter menu

(LT, For selecting shutter speed and aperture value) will
be displayed.

3. Configure the Long Time shutter value with the up/ down/
left/ right button.
Up/ Down Button : Select the Aperture/ Shutter speed
Left/ Right Button : Change the value. Available aperture value options, depending on

zoom step will be displayed on the menu.
4. Press the +/- button again. The value you set will be saved and the mode will switch to

NIGHT SCENE mode. Press the SHUTTER button to take the picture.

Aperture Value

Shutter Speed

Large/Small
(Press right button)

Large/Small
(Press left button)

Fast/Slow
(Press left button)

Fast/Slow
(Press right button)

■ Aperture values and shutter speeds changed by zoom scale are listed below.

F 3.5

1 S 

Supported Aperture Values : AUTO, WIDE : F3.5 ~ F6.3, TELE : F4.5 ~ F8.0
Supported Shutter Speeds : AUTO, 1 ~ 16S

� �

� �
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Using the LCD monitor to adjust the camera settings
■ You can use the menu on the LCD monitor to set up recording functions. In any mode with

the exception of VOICE RECORDING mode, pressing the MENU button displays the menu
on the LCD monitor.

■ The following functions are available, depending on the mode you have selected.
The items indicated by                       are default settings.

● The menu will not be displayed on the LCD monitor in the following circumstances:
- When another button is being operated.
- While image data is being processed. 
- When there is no battery capacity.

INFORMATION

Menu tab Main menu Sub menu Camera working mode Page

Still/ Movie/ MP3

Full

Auto Manual

Movie Night

Portrait Children

Mode set Landscape Close up p.49

Text Sunset

Dawn Backlight

Firework Beach & Snow

2592X1944 2272X1704

2048X1536 1600X1200 p.50

1024X768 640X480

640X480 320X240

160X128 -

S.Fine Fine

Normal -

Mode

Quality

Size
(Movie)

Size
(Still image)

p.48, 107

p.50

p.51
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Using the LCD monitor to adjust the camera settings

※ Menus are subject to change without prior notice.

Menu tab Main menu Sub menu Camera working mode Page

Frame Rate 30fps 15fps p.51

Metering Multi Spot p.52

Shooting Single Continuous p.52

Soft Normal

Vivid -

Full OSD Basic OSD

Save Mode -

Normal Red

B&W Green

Sepia  Blue

Negative -

Highlight Off Range 1 ~ 4 p.55

Off  2~4 Parts

Pano. 2 Parts  -

Photo Frame Off  Frame 1 ~ 9 p.59

Stabilizer Off On p.60

Sharpness

Effect

OSD 
Information

Composite

p.53

p.53

p.54

p.57
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How to use the menu

3. Use the UP and DOWN buttons to select a sub menu.

4. Select a sub menu, and then the value you set will be saved. Press the MENU button and
the menu will disappear.

■ You can select the desired working mode using the M (mode) button located on the back of
the camera aand via the [mode] menu. Auto, manual, Voice Recording, movie clip, scene
(night, portrait, children, landscape, text recognition, close-up, sunset, dawn, backlight,
fireworks, beach & snow) camera modes are available. Refer to page 106 for more
information about the MP3 mode. 

[Still/ Movie/ MP3] : A still image mode that was selected on
the [Mode set] menu and movie clip
mode can be selected.

[Full] : Auto, Manual, Voice Recording, Movie
clip and scene modes can be selected.

1. Turn on the camera and press the MENU button. A menu for each camera mode appears.
However, there is no menu for Voice Recording mode (          ).

2. Use the LEFT and RIGHT buttons to navigate through the menus.

Mode

Still/ Movie/ MP3
Full

Mode

Press the LEFT 
or RIGHT button.

Press the LEFT 
or RIGHT button.

Press the UP or
DOWN button.

Press the UP or
DOWN button.

Auto
Manual

Movie
Night

portrait
Children

Mode Set

2592 X 1944
2272 X 1704
2048 X 1536
1600 X 1200
1024 X 768
640 X 480

Size

Still/ Movie/ MP3
Full

Mode

Auto
Manual

Movie
Night

portrait
Children

Mode Set
Auto

Manual 
Movie

Night
portrait

Children

Mode Set

Auto
Manual 

Movie 
Night

portrait
Children

Mode Set
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Mode Set
■ You can select the desired recording mode.

[Auto] : For shooting basic still image
[Manual] : You can still manually configure all

functions except the aperture value and
shutter speed.

[Movie] : For taking a movie clip 
[Night] : Use this for shooting still images at night

or in other dark conditions.
[Portrait] : To take a picture of a person.
[Children] : To take a picture of fast moving objects, for example, children.
[Landscape] : To take pictures of distant scenery.
[Close up] : Close-up shooting for small objects such as plants and insects.
[Text] : Use this mode to shoot a document.
[Sunset] : For taking pictures of sunsets.
[Dawn] : Daybreak scenes.
[Backlight] : Portrait without shadows caused by backlight.
[Firework] : Firework scenes.
[Beach & Snow] : For ocean, lake, beach and snowscape scenes.

● When [Night], [Landscape], [Close up], [Text], [Sunset], [Dawn] and [Firework] scene
mode are selected, it is possible that camera shake will occur. In this case, take care of
the camera shaking.

INFORMATION

Auto
Manual

Movie
Night

portrait
Children

Mode Set
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Size
■ You can select the image size appropriate for your application.

Icon 5M 4M 3M 2M 1M VGA 640 320 160

Size 2592X1944 2272X1704 2048X1536 1600X1200 1024X768 640X480 640X480 320X240 160X128

STILL IMAGE modeMode MOVIE CLIP mode

● The higher the resolution, the lower the number of available shots will be because high
resolution images require more memory than lower resolution images.

INFORMATION

[ STILL IMAGE mode ] [ MOVIE CLIP mode ]

2592 X 1944
2272 X 1704
2048 X 1536
1600 X 1200
1024 X 768
640 X 480

Size

640 X 480
320 X 240
160 X 128

Size
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Quality/ Frame rate
■ You can select the compression ratio appropriate for your application of the captured images.

The higher the compression ratio, the lower the picture quality.

Mode  

Icon

Sub menu S. Fine Fine Normal 30FPS 15FPS

File Format jpeg jpeg jpeg avi avi 

STILL IMAGE mode MOVIE CLIP mode

● S. Fine is the highest quality and Normal is the lowest setting.
Choose the setting appropriate for your needs.

● This file format complies with the DCF(Design rule for Camera File system).
● JPEG (Joint Photographic Experts Group) : 

JPEG is the image compression standard developed by the Joint Photographic Experts
Group. This type of compression is most commonly used for compressing photos and
graphics because it can compress the files efficiently without damaging the data.

INFORMATION

[ STILL IMAGE mode ] [ MOVIE CLIP mode ]

30 FPS
15 FPS

Frame Rate

S.Fine
Fine

Normal

Quality
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Metering

■ Select the number of pictures in continuous shooting.

[Single] : Take one picture only 
[Continuous] : Images will be taken continuously until the

shutter button is released. The shooting
capacity depends on the memory. 

※ High resolution and picture quality increases file saving
time, which increases stand-by time.

※ If the [Continuous] sub menu is selected, the flash will
be off automatically.

[MANUAL mode]

■ If you cannot obtain suitable exposure conditions, you can change the metering method to
take brighter pictures.

[Multi] (           ) : Exposure will be calculated based on an
average of the available light in the image
area. However, the calculation will be
biased towards the centre of the image
area. This is suitable for general use.

[Spot] (           ) : Only the rectangular area in the centre
of the LCD monitor will be metered for
light. This is suitable when the subject in
the centre is exposed correctly, regardless of the back lighting. 

● The default metering mode is Multi pattern metering.
● If the subject is not the centre of the focus area, do not use the spot metering as this may

result in an exposure error. In this circumstance, It is better to use exposure
compensation.

INFORMATION

Continuous shot

[STILL IMAGE mode]

Multi
Spot

Metering

Single
Continuous

Shooting
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Sharpness

OSD(On Screen Display) information

■ You can adjust the sharpness of the picture you want to take.
You cannot check the sharpness effect on the LCD monitor
before you take a picture, because this function is applied
only when the captured image is stored on the memory. 

Sub menu Icon Description 

The edges of the image are softened. 

This effect is suitable for editing images on your PC.

The edges of the image are sharp. 

This is suitable for printing.

The edges of the image are emphasized. The edges will appear

sharp, but noise may occur in the recorded image.
Vivid

Normal

Soft

■ In any mode with the exception of VOICE RECORDING
mode, you can check the recording status in the LCD monitor.

■ Idle mode : If you select the [Save Mode] and the camera isn't
operated during the specified time(about 30
SEC.), the camera power will be idle (LCD
monitor : OFF, Camera status lamp : Blinking)
automatically.

- To use the camera again, press any of the camera buttons except the power button.
- If there is no operation during the specified time, the camera power will be turned off
automatically to save battery life. Refer to page 96 for more information about the auto
power off function.

Full OSD
Basic OSD
Save Mode

OSD Infomation

[Full information mode] [Basic information mode] [Power save mode]

Full Inf. Mode Basic Inf. Mode Save Mode

Soft
Normal

Vivid

Sharpness
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Effect
■ By using the camera’s digital processor, it is possible to add special effects to your images.

[Normal] : No effect is added to the image.
[B & W] : Captured images will be stored in black and white.
[Sepia] : Captured images will be stored in a sepia tone 

(a gradient of yellowish brown colours).
[Red] : Captured images will be stored in a red tone.
[Green] : Captured images will be stored in a green tone.
[Blue] : Captured images will be stored in a blue tone.
[Negative] : Save the image in negative mode. 

[MANUAL mode] [ MOVIE CLIP mode]

Normal
B & W
Sepia

Red
Green

Blue

Effect

Normal
B & W
Sepia

Red
Green

Blue

Effect



《55》

Special Effect

■ You can make the subject stand out from its surroundings. 
The subject will be sharp and in focus while making the rest out of focus.

1. Select the MANUAL mode, and press the menu button. 
2. Press the LEFT/ RIGHT button and select the 

[Special Effect] menu tab.
3. Select the [HighLight] menu by pressing the UP/ DOWN

button and press the Right button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
- [Off] : The preset focus frame will not be added. 

■ By using the camera’s digital processor, it is possible to add special effects to your images.
You can select this menu only in the MANUAL mode.

■ You can select the preset focus frame, Composite shooting and Photo frame function. If a
special effect is selected, the rest special functions set before are cancelled automatically. 

■ Even if the camera is turned off, the special effect setting will be preserved. 
To cancel the special effect, select the [Off] sub menu of each menu. 

■ The digital zoom function will not activate in the special effect menu. 

■ Date & Time information will not be displayed on the LCD monitor in the special effect menu. 

Special Effect : Preset focus frames

5. Press the menu button twice and the menu will disappear.
If you select the [Range 1 ~ 4] menu, the preset focus
frame area will appear. 

[Range 1] [Range 2] [Range 3] [Range 4]

HighLight
Composite
Photo Frame

Off
Range 1
Range 2
Range 3
Range 4

Special Effect

Back:◀ Set:OK

Capture:SH Edit:+/-
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Special Effect : Preset focus frames
● Moving and changing the focus frame

You can change the focus frame after selecting a Range menu.
1. Point the camera towards the subject and compose the image by using the LCD monitor. 
2. Press the +/- button. 
3. The colour of focus frame turns white. Press the Up/Down/Left/Right button to moves the

focus frame position. 
4. To select the focus frame position, press the +/- button again and you can take a picture. 

Pressing the +/- button

[The frame is activated]

[After changing the frame position]

Pressing the +/- button

Pressing the 
Up/ Down/ Left/ Right

button

Capture:SH Edit:+/- Capture:SH Move: ����

Capture:SH Move: ����Capture:SH Edit:+/-
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Special Effect : Composite shooting
■ You can combine 2 ~ 4 different shots in a still image.

※ You can use the flash button, self-timer button, macro button, voice memo button and the
Zoom W/T button during the composite shooting.

※ If you press the camera buttons (SF button, Play mode button
and M button) during the composite shots, each mode of the
camera buttons is executed. The images captured before will
be deleted. 

※ If you press the Menu button during the composite shots, a
window will display. Select the submenu value by pressing the
Up/Down button and then press the OK button.
[Menu] : A menu will display. After confirming a menu, 

a camera mode used before will be executed. 
[Cancel] : Turns to the previous capture mode. 

※ After taking the last composite shooting, press the OK button. 
And then the voice memo will start. 

※ Selecting 2 composite shooting

7. To save the composite shots, press the OK button after taking the last shot. 

1. Select the MANUAL mode, and press the menu button.
2. Press the LEFT/ RIGHT button and select the 

[Special Effect] menu tab.
3. Select the [Composite] menu by pressing the UP/ DOWN

button and press the Right button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
- [Off] : cancels the composite shooting
- [2 Parts] : 2 different shots are combined in a still image. 
- [3 Parts] : 3 different shots are combined in a still image.
- [4 Parts] : 4 different shots are combined in a still image.
- [Pano. 2 Parts] : 2 different panorama shots are combined in a still image. 

5. Press the menu button twice and the menu will disappear.
6. The number of frames you selected in step 4 is displayed on the LCD monitor. 

Press the shutter button to start the composite shooting

HighLight
Composite
Photo Frame

Off
2 Parts
3 Parts
4 Parts
PANO.2 Part

Special Effect

Back:◀ Set:OK

[Ready for taking]

Pressing
the shutter

button

[First shot]

Pressing 
the shutter

button

[Second shot]

Pressing
the OK
button

[The final picture]

Menu?

Menu

Cancel

Confirm:OK

Save:OK Del:+/-Capture:SH Del:+/-

Capture:SH Del:+/-
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Special Effect : Composite shooting
● Changing a part of composite shot before taking the last shot

Before taking the last composite shot, you can change a part of composite shot. 
1. During the composite shots, press the +/- button. 
2. A previous image will be deleted and new frame will display. If there is an image taken

before, press the +/- button again and a previous image will be deleted again. 

3. Press the shutter button to capture a new image.

● Changing a part of composite shot after taking the last shot
After taking the last composite shot, you can change a part of composite shot. 
1. After taking the last shot , a cursor to select a frame will display. 

Press the Up/ Down/ Left/ Right button to select the frame. 
2. Press the +/- button and an image will be deleted. Composite frame will be activated. 
3. Press the Shutter button. You can take another images again by using the 

Up/ Down/ Left/ Right button and +/- button.
4. Press the OK button again to save the captured image.

[After taking the 4th shot]

Pressing the 
Up button

[Moving backward to the 2nd shot] [Deleting the 2nd shot] 

[The final picture]

Pressing the
OK button 

[After taking the 2nd shot again]

Pressing the
Shutter button. 

Pressing the 
+/- button

Pressing the +/- button

[Before taking the 3rd shot] [Moving backward to the 2nd shot]

Save:OK Del:+/- Save:OK Del:+/-

Save:OK Del:+/-

Capture:SH Del:+/- Capture:SH Del:+/-
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Special Effect : Photo Frame
■ You can add 9 types of frame-like borders to a still image you want to capture.

■ Date & Time information will not be printed on the stored image taken with [Photo Frame]
menu. 

1. Select the MANUAL mode, and press the menu button.
2. Press the LEFT/ RIGHT button and select the 

[Special Effect] menu tab.
3. Select the [Photo Frame] menu by pressing the UP/ DOWN

button and press the Right button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
- [Off] : The photo frame will not be added. 

5. Press the menu button twice and the menu will disappear.
If you select the [Frame 1 ~ 9] menu, the selected photo
frame will appear.

※ Before taking a picture, you can change the frame type by
pressing the +/- button. Change the frame type by
pressing the Up/ Down/ Left/ Right button.

[Frame 1] [Frame 2] [Frame 3]

[Frame 4] [Frame 5] [Frame 6]

[Frame 7] [Frame 8] [Frame 9]

HighLight
Composite
Photo Frame

Off
Frame1
Frame2
Frame3
Frame4

Special Effect

Back:◀ Set:OK

Capture:SH Frame:+/-
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Movie Clip frame stabiliser
■ This function helps stabilize images captured during movie recording. 

You can select this menu only in the MOVIE CLIP mode. If the memory card is not inserted,
this function will not operate.

● How to use this function 
1. Select the MOVIE CLIP mode by pressing the M (Mode)

button and press the menu button. Press the Left/ Right
button to select the [Stabilizer] menu.

2. Select a desired sub menu by pressing the Up/Down
button and press the OK button. 
- [Off] : Movie clip frame stabilizer function becomes

disabled. 
- [On] : Prevents camera shake during movie recording. The recording frame range will

become narrower than when you select the [Off] menu. Pre-view frames may not
display smoothly on the LCD monitor.

● When you select the [On] sub menu, the movie clip frame range will be narrow depending
on the movie clip size. 

INFORMATION

Off
On

Stabilizer
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Starting play mode
■ Turn the camera on and select Play mode by pressing the play mode button (        ). 

The camera can now play back the images stored in the memory. 

■ You can set up the PLAY mode function by using the camera buttons and LCD monitor.

■ If the memory card is inserted in the camera, all the camera functions apply only to the
memory card.

■ If the memory card is not inserted in the camera, all the camera functions apply only to the
internal memory.

3. Select an image that you want to view by
pressing the LEFT/ RIGHT button.

※ Press and hold the LEFT or RIGHT button to
play back the images quickly.

2. The last image stored on the memory is
displayed on the LCD monitor.

● Playing back a still image
1. Select the PLAY mode by pressing the play

mode button (         ).

● Manner mode : Pressing the power button for more than 3 seconds changes the buzzer
and start-up sound setting to OFF, even though you may have set these
to ON.

INFORMATION 
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Starting play mode
● Playing back a movie clip

Steps from 1-2 are the same as those to play back a still
image.
3. Select the recorded movie clip that you want to play back

by using the LEFT/RIGHT button. If you select a movie
clip, the movie clip indicator (         ) will be displayed on
the LCD monitor.

4. Press the play & pause button (             ) to play back a
movie clip file.
- To pause a movie clip file while playing it back, press
the play & pause button again.

- Pressing the play & pause button again will cause the
movie clip file will restart.

- To rewind the movie clip while it is playing, press the
LEFT button. To fast forward the movie clip, press the RIGHT button.

- To stop playback of the movie clip, press the play & pause button, and then press the
LEFT or RIGHT button.

● How to capture the movie clip
Steps 1-2 are the same as those for playing back a still
image.
3. Select the recorded movie clip that you want to play

back by using the LEFT/ RIGHT button.
4. Press the Play/ Pause button to play the movie clip
5. Press the Play/ Pause button while playing the movie

clip. Then press the Shutter button.
6. The paused movie clip is saved in a new file name.
※ The captured movie clip file has same size as the

original movie clip (640X480, 320X240, 160X128).

■ Movie clip capture function : capture still images from the movie clip.

PAUSE?

[Paused]

[Press the shutter button]

Trim:T Capture:SH
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Starting play mode
■ On camera movie trimming : You can extract desired frames of movie clip during the movie

clip play back. 

● If the running time is under 10 seconds, the movie clip can’t
be trimmed.
1. Select a desired movie clip in the play mode. 
2. Play back the movie clip by pressing the Play & Pause

button.
3. Press the Pause button at the point of the movie clip that

you want to start extracting. 
4. Press the T button. (The start point doesn't display on the

status bar, but the start point will be marked.)
5. Press the Play & Pause button and the extracted range will

be displayed on the status bar. 
6. Press the Play & Pause button once more at the point

where you wish the extracted file to stop. 

7. Press the T button and a confirmation window will display.

8. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Trimming] : The extracted frames are saved as a new file

name. 
[Cancel] : The movie trimming will cancel. 

● When a voice is playing back, you can use the earphones. 
● If you want to extract the movie clip at the beginning of the frame, press the Zoom T

button before starting the movie clip. (The start point doesn’t display on the status bar, but
the start point is selected.)

● If the time line bar passes by the start point by pressing the REW(Left) button, the first
frame of the movie clip will display. 

● If you doesn’t specify the ending point of the movie clip, the trimming confirmation window
will display at the point of the last frame.

INFORMATION 

PAUSE?

Trim:T Capture:SH

Trim:T

Trimming?

Trimming

Cancel

Confirm:OK
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Starting play mode
● Playing back a recorded voice

Steps from 1-2 are the same as those to play back a still
image.
3. Select the recorded voice that you want to play back by

using the LEFT/ RIGHT button. If you select a recorded
voice file, the voice indicator (        ) will be displayed on
the LCD monitor.

4. Press the play & pause button (             ) to play back a
recorded voice file.
- To pause a recorded voice file, while playing it back, press the play & pause button again.
- To resume playback of the voice file, press the play & pause button.
- To rewind the voice file while it is playing, press the LEFT button. 
To fast forward the voice file, press the RIGHT button.

- To stop playback of the voice file, press the play & pause button, and then press the
LEFT or RIGHT button.

- When a voice is playing back, you can use the earphones.
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■ Shooting information is displayed as follows.

LCD monitor indicator
■ The LCD monitor displays shooting information about the displayed image.

Size : 2592X1944 Size
Av : F3.5 Aperture value
Tv : 1/60 Shutter speed
ISO : 100 ISO sensitivity
Flash : Off Whether or not the 

flash is used
Date : 2005/05/01 Recording date

Size : 2592X1944
Av : F3.5
Tv : 1/60

ISO : 100 
Flash : Off
Date : 2005/05/01

⑦
⑧②

①

③

④

⑤

⑥

No. Description Icon Page

1 Play mode -

2 Battery p.17

3 File Type -

4 Voice memo p.69

5 Protect indicator p.80

6 DPOF indicator p.84

7 Folder name and Stored image number 100-0009 -

8 Volume display p.68
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Using the camera buttons to adjust the camera
■ In Play mode, you can use the buttons on the camera to conveniently set up the Play mode

functions.

■ If you have turned on the camera by pressing the POWER button, you can press the PLAY
MODE button once to switch to Play mode and press it again to switch to Recording mode.

■ You can turn the power on with the play mode button. The camera is turned on in play mode.
Press the play mode button (Under 1 Sec.) again to turn off the camera.

■ Pressing the Play mode button for over 1 Sec., you can check the recording information.

Play mode button

[Play mode display] [Recording information]

Pressing for over 1 Sec.

Pressing the Play mode button

Size : 2592X1944
Av : F3.5
Tv : 1/60

ISO : 100 
Flash : Off
Date : 2005/05/01
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Thumbnail(       )/ Enlargement(      ) button/ Volume button(           )

● Image enlargement
1. Select an image that you want to enlarge and press the enlargement button.
2. Different parts of the image can be viewed by pressing

the 5 function button.
3. Pressing the thumbnail button will zoom back to the

original full sized image.
- You can tell whether the image displayed is an enlarged
view by checking the image enlargement indicator
shown at the bottom left of the LCD monitor. 
(If the image is not an enlarged view, the indicator will
not be displayed.) You can also check the area of
enlargement.

- Movie clips and WAV files can’t be enlarged.
- If an image is enlarged, a loss of quality may occur.

■ You can view multiple pictures, enlarge a selected picture, and crop and save a selected area
of an image.

■ When a movie clip, voice memo or voice recording file is playing back, you can control the
volume of those files using this button.

● Thumbnail display
1. While an image is displayed full screen, press the thumbnail

button.
2. The thumbnail display will highlight the image that had been

showing at the time the thumbnail mode was selected.
3. Press the 5 function button to move to a desired image.
4. To view an image separately, press the enlargement button.

[Normal display mode] [Thumbnail display mode]

Pressing the thumbnail 
button (         )

Pressing the enlargement
button (          )

Highlighted image

X1.5
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Thumbnail(       )/ Enlargement(      ) button/ Volume button(           )
● The maximum enlargement rate in proportion to the image size.

● Trimming : You can extract part of the image that you want and save it separately.
1. Select an image that you want to enlarge and press the

enlargement button.
2. Different parts of the image can be viewed by pressing the

5 function button.
3. Press the MENU button and a message will be displayed

as shown alongside.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Trimming] : The trimmed image will save as a new file name, and display on the LCD

monitor. 
[Cancel] : The trimming menu will disappear. 

※ If there is little memory space to save the trimmed image, the image can’t be trimmed.
※ To delete the enlarged image during the trimming function, press the delete button.

Image size 2592 2272 2048 1600 1024 640

Maximum enlargement rate X10.1 X8.8 X8.0 X6.2 X4.0 X2.5

X1.5

Trimming?

Trimming

Cancel

Confirm:OK

● Volume control : When a movie clip, voice memo or voice
recording file is playing back, can control
the volume using this button.

PAUSE?

[Movie Clip : Playing back] [Movie Clip : Stop] 



《69》

Voice (     ) memo/ Up button

3. Press the shutter button to start recording and voice will
be recorded to the still image for 10 seconds. 
While the voice is recording, the recording status window
will be displayed as shown alongside.

4. The recording can be stopped by pressing the shutter
button again.

5. The (        ) icon will be displayed on the LCD monitor
after voice memo recording has finished. 
- Voice memos can’t be recorded onto movie clip files.
- A distance of 40cm between you and the camera
(microphone) is the best distance to record sound.

- The voice memo will be saved in ҭ.wav format, but has
the same file name as the still image to which it
corresponds.

- If you add a new voice memo to the still image that already has a voice memo, the
existing voice memo will be erased.

■ When the menu is displayed on the LCD monitor, pressing the UP button makes the menu
cursor move up. 

■ When the menu is not displayed on the LCD monitor, the UP button operates as the voice
memo button. You can add your voice to a stored still image.

● Adding a Voice Memo to a Still Image
1. Press the LEFT/ RIGHT button to select an image that

you wish to add sound to.
2. Press the voice memo button (        ) and the voice memo

indicator will display. The camera is now ready to record
a voice memo.
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Play & Pause (          )/ Down button

■ This deletes images stored on the memory card.

● Deleting Images in Play Mode
1. Select an image that you want to delete by pressing the

LEFT/ RIGHT button and press the DELETE(         )
button.

2. A message will display as shown alongside on the LCD
monitor.

3. Select the submenu values by pressing the UP/ DOWN
button and then press the OK button.
If [Delete] is selected : deletes the selected images.
If [Cancel] is selected : cancels "Delete Image".

Delete (     ) button

■ In Play mode, the play & pause/ down button works as follows:

- If the menu is displayed
Press the DOWN button to move from the main menu to a sub menu, or to move down the
sub menu cursor.

- If a still image with a voice memo, a voice file, or a movie clip is playing
In Stop mode : Plays a still image with a voice memo, a voice file, or a movie clip.
During playback : Temporarily stops playback.
In Pause mode : Resumes playback

[Voice recording is stopped] [Voice recording is paused][Voice recording is playing]

Delete?

Delete

Cancel

Confirm:OK
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Delete (     ) button

■ LEFT / RIGHT/ MENU/ OK buttons activate the following.

- LEFT button : While the menu is showing, press the LEFT button to select the menu tab
to the left of the cursor. While the menu is not showing, press the LEFT
button to select the previous image. 

- RIGHT button : While the menu is showing, press the RIGHT button to select the menu
tab to the right of the cursor, or to move an secondary menu. While the
menu is not showing, press the RIGHT button to select the next image. 

- MENU button : When you press the MENU button, the play mode menu will be displayed
on the LCD monitor. Pressing it again will return the LCD to the initial
display.

- OK button : When the menu is displayed on the LCD monitor, the OK button is used
for confirming data that is changed by using the 5 function button.

● Before deleting images from the camera, you should protect or download images to your
computer that you wish to keep.

INFORMATION 

● Deleting Images in Thumbnail Display Mode
1. Use the UP, DOWN, LEFT, and RIGHT buttons to select the image you want to delete,

and then press the DELETE (        ) button.
2. The following message will be displayed on the LCD monitor.
3. Select the submenu values by pressing the UP/ DOWN button and then press the OK

button.
If [Delete] is selected : deletes the selected images.
If [Cancel] is selected : cancels "Delete Image".

Press the 
DELETE button.

Delete?

Delete

Cancel

Confirm:OK

Left/ Right/ Menu/ OK button
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Album button

Select

Slide

Add

Remove

■ You can organise the captured still images into albums by
using the Album  button.

■ This camera has 8 albums and each album can take up to
100 images. 

■ The album menu loading time depends on the memory
card type.  

● Inserting still images into the album
1. Select an album.
2. Select the [Add] menu by pressing the Up/Down button

and press the Right button. 

※If there are over 300 images in the memory, the [Add]
menu takes a little longer for the camera to process.

■ How to use the album

● Selecting the album
1. In the play mode, press the Album button. 
2. Select the [Select] menu by pressing the Up/ Down

button and press the Right button. 

3. Select a desired album by pressing the 
Up/ Down/ Left/ Right buttons and press the OK button. 

Exit:MENU Move:      ��

Select

Slide

Add

Remove

Set:OK

Select

Slide

Add

Remove

Select:T Set:OK
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Select:T Set:OK

Select

Slide

Add

Remove

Select:T Set:OK

Select

Slide

Add

Remove

Set:OK

Album button
3. Select the still images you wish to add by pressing the

Up/Down/Left/Right buttons and press the Zoom T
button.       marks are displayed on the selected images.

※ To cancel the selection, press the Zoom T button again. 

4. Press the OK button and a confirmation window will
display. Select a desired sub menu by pressing the 
UP/ DOWN button and press the OK button.
- [Add] : Inserts the selected images into the album.  
- [Cancel] : Cancels the inserting images.

● Removing still images from the album
1. Select an album.
2. Select [Remove] menu by pressing the Up/Down button

and press the Right button. 
3. Select a desired sub menu and press the OK button. 

- [All Pics]: All of the still images in the album will be
removed. 

- [Select] : Specific still images in the album can be
removed. 

※ If [Select] is selected
- Select images that you want to remove by pressing the
Up/ Down/ Left/ Right buttons and press the 
Zoom T button.       marks are displayed on the
selected images. 

4. Press the OK button and a confirmation window will
display. Select a desired sub menu by pressing the 
UP/ DOWN button and press the OK button.
- [Remove] : Removes the selected images from the

album.  
- [Cancel] : Cancels the removing images.

※ The removed images are not deleted from the memory,
but just removed from the album.

Add?

Add

Cancel

Confirm:OK

Select:T Set:OK

Remove?

Remove

Cancel

Confirm:OK

Select

Slide

Add

Remove

Select:T Set:OK

Select

All Pics
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Album button

● If an image is deleted from the memory, the image doesn’t display on an album. 
● An image can’t be added twice into the same album. 
● An image can be added into the different albums. 

INFORMATION

● Playing back the albums
◎ Playing back all of the albums
1. Select [All] menu and press the OK button. 

All of the albums will be selected. 
2. Select [Slide] menu by pressing the Up/ Down button

and press the Right button. 
※ You can select [Start], [Interval], [Repeat] and [Effect]

menus. 
- [Start] : Start the slide show
- [Interval] : Set the slide show play interval
- [Repeat] : Choose to repeat the slide show after

finishing the first cycle. 
- [Effect] : Unique screen effects can be used for the

slide show.
3. Select [Start] menu by pressing the Up/ Down button and

press the OK button to start the slide show. 
4. Press the MENU/ OK button and the slide show will stop.

◎ Playing a desired album
1. Select a desired album and press the OK button. 
2. Select [Slide] menu by pressing the Up/Down button and

press the Right button. 
※ You can select [Start], [Interval], [Repeat] and [Effect]

menu.
3. Select the [Start] menu and press the OK button to start

the slide show. 
4. Press the MENU/ OK button and the slide show will stop.

Select

Slide

Add

Remove

Exit:MENU Move:      

Start

Interval 1 sec

Off

Cancel

Repeat

Effect

Select

Slide

Add

Remove

Exit:MENU Move:      ��

��

Select

Slide

Add

Remove

Move:     Set:OK 

Start

Interval 1 sec

Off

Cancel

Repeat

Effect

Select

Slide

Add

Remove

Exit:MENU Move:      ��

��
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Setting up the play back function using the LCD monitor

Menu tab Main menu Sub menu Secondary menu Page

Start -

Interval 1, 3, 5, 10sec

Slide Repeat Off / On p.78

Cancel

Effect 1 ~ 4, Random

Select 

All Pics

Select -

All Pics -

2272X1704 -

2048X1536 -

1600X1200 -

1024X768 -

640X480 -

User Image -

B&W Red

Effect Sepia Green p.83

Negative Blue

Right 90˚ -

Left 90˚ -

Rotate 180˚ - p.84

Horizontal -

Vertical -

Standard Select/ All Pics/ Cancel

DPOF Index No/ Yes p.84

Size Select/ All Pics/ Cancel

■ PLAY mode functions can be changed by using the LCD monitor. In the PLAY mode,
pressing the MENU button displays the menu on the LCD monitor. The menus you can set
up in Play mode are as follows. To capture an image after setting up the play menu, press
the PLAY mode button or shutter button.

p.80

p.81

p.82

Protect Unlock / Lock

Delete

Resize

Effect
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Setting up the play back function using the LCD monitor

Menu tab Main menu Sub menu Secondary menu Page

One Pic -

All Pics -

No -

Yes -

Auto

Postcard

Card

4X6

L

2L

Letter

A4

A3 p.91

Auto

Full

1

2

4

8

9

16

Auto Set

Custom Set

Images

Layout

Size

Menu tab Main menu Sub menu Secondary menu Page

No -

Yes -

Full OSD -

OSD Off -

p.87

p.88

p.90

p.91

■ This menu is available while the camera is connected to a PictBridge supporting printer
(direct connection to the camera, sold separately) with a USB cable.

Copy to Card

OSD Information
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Setting up the play back function using the LCD monitor
Menu tab Main menu Sub menu Secondary menu Page

Auto

Plain

Photo

Fastphoto

Auto

Draft

Normal

Fine

Auto

Date Off

On

Auto

File Name Off

On 

Standard -

Index - 

No -

Yes -

No -

Yes -

Print

Custom Set

p.92

p.92

p.93

p.91

DPOF Print

Reset

※ Menus are subject to change without prior notice.

Quality

Type
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Starting the slide show

● The loading time depends on the image size and quality.
● While the slide show is playing, only the first frame of a MOVIE file is displayed.
● While the slide show is playing, the voice recording file will not display. 

INFORMATION

● Start the slide show : The slide show can start only in the [Start] menu.
1. Use the Up/Down buttons to select the [Start] menu.
2. Press the OK button to start the slide show.
- Press the Pause button to pause the slide show.
- Press the Pause button (              ) again to resume the slide
show.

- To stop the slide show, press the play & pause button, and
then press the LEFT or RIGHT button.

■ Images can be displayed continuously at pre-set intervals.
You can view the slide show by connecting the camera to an external monitor.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Slide] menu tab.

● Setting play interval: Set the slide show play interval.
1. Select the [Interval] sub menu by pressing the UP/DOWN

button and press the RIGHT button.
2. Use the Up/ Down buttons to select the desired interval.
3. Press the OK button to save the configuration.

● Repeat setting : Setting the slide show to repeat after the first cycle.
1. Use the Up/ Down buttons to select the [Repeat] menu and

press the Right button.
2. Use the Up/Down buttons to select the desired sub menu.

[On] selected : The slide show is repeated until cancelled.
[Off] selected : The slide show is closed after one cycle.

3. Press the OK button to save the configuration.

Start
Interval
Repeat
Effect

Slide

Move: Set:OK��

1 sec
Off
Cancel

Start
Interval
Repeat
Effect

Slide

Back:◀ Set:OK

1 sec
3 sec
5 sec
10 sec

Start
Interval
Repeat
Effect

Off
On

Slide

Back:◀ Set:OK
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Starting the slide show
● Configure slide show effects: Unique screen effects can be used for the slide show.

1. Select the [Effect] sub menu by pressing the UP/ DOWN
button and press the RIGHT button.

2. Use the Up/ Down Button to select the type of effect.
[Cancel] : Normal display.
[Effect 1] : Image is displayed slowly.
[Effect 2] : Image is displayed slowly from the centre

outwards.
[Effect 3] : Image moves from the top left.
[Effect 4] : The image slides diagonally from top left to bottom right. 
[Random] : The image slides irregularly.

3. Press the OK button to confirm the setting.

Start
Interval
Repeat
Effect

Cancel
Effect 1
Effect 2
Effect 3
Effect 4

Slide

Back:◀ Set:OK
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Protecting images
■ This is used to protect specific shots from being accidentally erased (Lock).

It also unprotects images that have been previously protected (Unlock).

● Protecting Images
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Protect]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select ] : Selection window for an image to be

protected/released is displayed.
- Up/Down/Left/Right : Select an image
- Zoom W/T Button : Protect/release the image
- Menu Button : Your changes will be saved and

the menu will disappear.
[All Pics] : Protect/release all saved images
- Zoom W/T Button : Protect/release the images
- Menu Button : Your changes will be saved and the

menu will disappear.

- If you protect an image, the protect icon will be displayed
on the LCD monitor. (An unprotected image has no
indicator)

- An image in LOCK mode will be protected from the
delete function or [Delete] functions, but will NOT be
protected from the [Format] function.

Protect

Exit:MENU Move:��

Select
All Pics

Set:OK

W◀ Unlock          ▶T

W◀ Unlock             ▶T

Set:OK
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Deleting images
■ Of all the files stored in the memory card, the unprotected files in the DCIM subfolder will be

deleted. Remember that this will permanently delete unprotected images. 
Important shots should be stored on a computer before deletion takes place. 
The startup image is stored in the camera's internal memory (i.e., not on the memory card)
and it will not be deleted even if you delete all files on the memory card.

● Deleting images
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Delete]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select] : Selection window for an image to delete is

displayed.
- Up/Down/Left/Right : Select an image
- Zoom T Button : Select the image for deletion.

(       mark)
- OK Button : Press the OK Button to display the

confirmation message. Select the
[Delete] menu and press the OK
button to delete       marked
images. 

[All Pics] : Displays confirmation window. Select the
[Delete] menu and press the OK button to
delete all unprotected images. If there aren’t
protected images, all the images are deleted
and a [No Image!] message will display. 

4. After deletion, the screen will be changed to the play
mode screen.

Select:T
Del:OK

Del:OK

Delete?

Delete

Cancel

Confirm:OK

Delete

Exit:MENU Move:��

Select
All Pics
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Resize

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Resize]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.

■ Change the resolution (size) of pictures taken. Select [User image] to save an image to be
the start-up image. The resized image will have a new file name.

● A large sized image can be resized to a smaller sized image, but not vice versa.
● Only JPEG images can be resized. Movie clip(AVI) and Voice recording(WAV) files can’t

be resized.
● You can change the resolution of only those files compressed in the JPEG 4:2:2 format.
● The resized image will have a new file name. The [User Image] image is stored not on the

memory card but on the internal memory.
● Only two [User Image] images can be saved. If you save a new [User Image] image, the

existing startup image will be deleted in order.
● If the memory capacity is insufficient to store the resized image, a [Card Full!] message

will display on the LCD monitor and the resized image will not be stored.

INFORMATION

Resize 2272X1704 2048X1536 1600X1200 1024X768 640X480 User image

5M O O O O O O

4M X O O O O O

3M X X O O O O

2M X X X O O O

1M X X X X O O

VGA X X X X X O

● Image Resize Types

Resize

Exit:MENU Move:��

2272 X 1704
2048 X 1538
1600 X 1200
1024 X 768
640 X 480
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■ By using the camera’s digital processor, it is possible to add special effects to your images.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Effect] menu

tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button.
[B & W] : Captured images will be stored in black and

white
[Sepia] : Captured images will be stored in a sepia tone

(a gradient of yellowish brown colours).
[Red] : Captured images will be stored in a red tone. 
[Green] : Captured images will be stored in a green tone.
[Blue] : Captured images will be stored in a blue tone.
[Negative] : Save the image in negative mode.

4. Press the OK button and then a confirmation window will
display. 
[Save] : The image with the effect added will be saved as a

new file with a new name.
[Cancel] : cancels the effect. 

Effect

Effect

Exit:MENU Move:��

B & W
Sepia
Red
Green
Blue

Save?

Save

Cancel 

Confirm : OK
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Rotating an image

■ DPOF(Digital Print Order Format) allows you to embed printing information on your memory
card’s MISC folder. Select the pictures to be printed and how many prints to make.

■ The DPOF indicator will display on the LCD monitor when an image that has DPOF
information plays back. Images can then be printed on DPOF printers, or at an increasing
number of photo labs.

■ This function is not available for Movie clips and Voice recording files.

DPOF 

■ You can rotate the stored images by various degrees. Once the playback of the rotated
picture is finished, it will switch back to the original state.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Rotate]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button.

4. Press the OK button and the rotated image will be displayed. 
If you display the rotated image on the LCD monitor, empty spaces may appear to the left
and right of the image.

Rotate

Exit:MENU Move:��

Right 90°
Left 90°
180°
Horizontal
Vertical

[Horizontal] : 
Rotate picture horizontally

[Vertical] : 
Rotate picture vertically 

[Right 90˚] : 
Rotate picture in a 
clock-wise direction

[Left 90˚] : 
Rotate picture in a counter-
clock-wise direction

[180˚] : 
Rotate picture 180
degrees
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DPOF : Standard
■ This function allows you to embed print quantity information on a stored image.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]

menu tab.
3. Select the [Standard] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select] : Selection window for an image to print is

displayed.
- Up/Down/Left/Right : Select an image to print.
- Zoom W/T Button : Select the number of prints.
[All Pics] : Configure number of prints for all pictures

except movie and voice files.
- W/T button : Select a number of prints
[Cancel] : Cancel the print setup.

5. Press the OK button to confirm the setting.
If an image carries DPOF instructions, the DPOF indicator
(         ) will show.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]

menu tab.
3. Select the [Index] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button.
If [No] is selected : Cancel the index print setting.
If [Yes] is selected : The image will be printed in index format.

5. Press the OK button to confirm the setting.

DPOF : Index

■ Images (except for movie clips and voice file) are printed as index type.

Standard
Index
Size

Select
All Pics
Cancel

DPOF

Back:◀ Set:OK

Set:OK

W◀ 0 Prints        ▶T

W◀ 0 Prints            ▶T

Set:OK

Standard
Index
Size

No
Yes

DPOF

Back:◀ Set:OK
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DPOF : Print size

● Setting the Print Size
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]

menu tab.
3. Select the [Size] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select] : Selection window for an image to be changed

printed size is displayed.
- Up/Down/Left/Right : Select an image.
- Zoom W/T Button : Change the print size.
- OK button : Your changes will be saved and the

menu will disappear.
[All Pics] : Change print size of all saved images.
- W/ T button : Select a print size
- OK button : Confirm the changed setting.
[Cancel] : Cancel all of the print size settings.

※ DPOF [Size] secondary menu : Cancel, 3X5, 4X6, 5X7,
8X10

※ Depending on the manufacturer and print model,
cancelling the printing may take a little longer for the printer
to process.

■ You can specify the print size when printing images stored on the memory card.
The [Size] menu is available only for DPOF 1.1 compatible printers.

Standard
Index
Size

Select
All Pics
Cancel

DPOF

Back:◀ Set:OK

Set:OK

W◀ Cancel         ▶T

W◀ Cancel            ▶T

Set:OK
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Copy To Card
■ This enables you to copy image files, movie clips and voice recording files to the memory card.

● Copying to the Memory Card
1. Press the play mode button and press the menu button.
2. Select the [Copy to Card] menu tab by pressing the 

LEFT/ RIGHT button.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
- [No] : Cancels "Copy to Card".
- [Yes] : All images, movie clips and voice recording files

saved in the internal memory are copied to the memory card after the
[Processing!] message is displayed. After copying has been completed, the
screen will return to play mode.

● When this menu is selected without inserting a memory card, you can select the 
[Copy to Card] menu but the menu can’t be run.

● If there is not enough space available in the memory card to copy saved images in the
internal memory (48MB), the [Copy to Card] command will copy only some of the images
and display [Card Full!] message. Then the system will return to the playback mode.
Please be sure to delete any unnecessary files to free up space before inserting the
memory card into the camera.

● When you move the images that are stored in the internal memory by doing 
[Copy to Card] to the card, the next number of file names will be created in the card to
avoid duplication of the file name. If the last file in the memory card is SSM10010.jpg, 
the copied file names start from SSM10011.jpg. After completing [Copy to Card], the last
stored image of the last copied folder is displayed on the LCD monitor. 

INFORMATION

Copy To Card

Exit:MENU Move:��

No
Yes
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On Screen Display information
■ You can check shooting information about the displayed image.

● How to select the type of information you want to see
1. Press the play mode button and press the menu button.
2. Select the [OSD Information] menu tab by pressing the

LEFT/ RIGHT button.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.

Full OSD
OSD Off

OSD Information

Exit:MENU Move:��

[OSD Off][Full OSD]

100-0004
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PictBridge

[Using the USB cable with Cradle]

[Using the USB cable with Camera]

■ Connecting the Camera to a Printer

● Using the USB cable with Cradle : 
Connect the camera and the cradle. Connect the cradle to a printer’s USB port with the
supplied USB cable. 

● Using the USB cable with Camera : 
Connect the camera to a printer’s USB port with the supplied USB cable.

● Setting up the camera for connection with the printer
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select [Setup] menu

tab.
3. Select [USB] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select [Printer] menu by pressing the UP/ DOWN button

and press the OK button.

※ If you selected [Computer] in Step 4, when you connect the camera to your printer, the
[Connecting Computer] message will display and the connection will not be established.
In this case, disconnect the USB cable, and then follow the procedure from Step 2 and
onward.

■ You can use the USB cable to connect this camera to a printer that supports PictBridge (sold
separately) and print the stored images directly. Movie clips and voice files cannot be printed.

Format
Date&Time
Imprint
Sound
USB

Computer
Printer

Setup

Back:◀ Set:OK
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PictBridge : Picture Selection
■ Easy printing

When you connect the camera to printer in the Play back
mode, you can print a picture easily. 
- Pressing the shutter button : Currently displayed image will

be printed with the printer’s
default setting. 

- Pressing the Left/ Right button : Selects a previous/ next
image.

[When [One Pic] is selected] [When [All Pics] is selected]

- Press the Up/ Down button to select the number of prints. 
- Use the Left/ Right button to select another picture and select the number of prints for
another picture.

- After setting the number of prints, press the OK button to save.
- Press the Shutter button to return to the menu without setting the number of prints.
- The maximum numbers of prints are 100 and if you select the number over 100, [Out Of
Number] message will display.

0

141-0001

● Setting the Number of Copies to Print
- Select [One Pic] or [All Pics]. A screen where you can set the number of copies to print will
appear as shown below.

Prev ◀▶ Next

▲

▼

■ Select pictures to print
1. The [Images] menu will appear.
2. Use the UP and DOWN buttons to select the desired

submenu value, and then press the OK button.
When [One Pic] is selected : The PictBridge function will be

applied only to the picture
currently displayed.

When [All Pics] is selected : The PictBridge function will be
applied to all pictures, excluding movie clips and voice files.

Exit:Shutter Set:OK

0
▲

▼

Exit:Shutter Set:OK

Images

Exit : MENU Move:��

One Pic
All Pics

141-0001

Print:Shutter Menu:OK

◀ ▶
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PictBridge : Print Setting

Menu

Size Setting the size of the printing paper Auto, Postcard, Card, 4X6, L, 2L, Letter, A4, A3

Setting the number of pictures to be 

printed on a sheet of paper

Type Setting the quality of the printing paper Auto, Plain, Photo, Fastphoto

Setting the quality of the picture to be 

printed

Date Setting whether to print the date Auto, Off, On

File Name Setting whether to print the file name Auto, Off, On

■ AUTO SET
1. Use the LEFT and RIGHT buttons to select the 

[Auto Set] menu tab.
2. Use the UP and DOWN buttons to select the desired

submenu value, and then press the OK button.
[No] : [Custom Set] values are kept.
[Yes] : All values in the [Custom Set] are automatically

changed.

※ Some menu options are not supported in all manufacturer and printer models. 
If not supported, the menus are still displayed in the LCD, but are not selectable.

※ If the setting values are not changed in the automatic/ manual setting, the setting values are
automatically kept.

1. Use the LEFT and RIGHT buttons to select the 
[Custom Set] menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the RIGHT button.

3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button. 

■ Custom Set : You can select the Paper Size, Print Format, Paper Type, Print Quality, Date
Print, and File Name Print menus for printed pictures.

Function

Auto, Draft, Normal, Fine

Auto, Full, 1, 2, 4, 8, 9, 16

Sub menu

Layout

Quality

● The menus you can set up are as follows:

Auto Set

Exit : MENU Move: ��

No
Yes

Size
Layout
Type
Quality
Date

Auto
Auto
Auto
Auto
Auto

Custom Set

Exit : MENU Move: ��
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1/1

Cancel:OK

PictBridge : Printing
■ Printing Pictures

1. Use the LEFT and RIGHT buttons to select the [Print]
menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[Standard] : Print the pictures stored in the memory card

in set numbers. One picture is printed on
one piece of paper.

[Index] : Print multiple images on one sheet of paper.
3. The screen shown on the right will appear and the picture

will be printed. If no picture is selected, the [No image!]
message will be displayed. Press the Menu/ OK button
while printing to cancel the printing and the [Print] menu
is displayed.

※ Number of pictures in an index print varies depends on the
printer used.

※ Depending on the manufacturer and print model, cancelling the printing may take a little
longer for the printer to process.

1. Use the LEFT and RIGHT buttons to select the 
[DPOF Print] menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[No] : Cancel the printing
[Yes] : Directly print the file with the DPOF information

※ Depending on the manufacturer and printer model, some menus may not be available. 
With a printer without supporting the DPOF, the menu is still displayed but not available.

■ DPOF Print : This allows you to directly print the files with DPOF information.

Now Printing

Print

Exit : MENU Move: ��

Standard
Index

DPOF Print

Exit : MENU Move: ��

No
Yes
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PictBridge : RESET

1. Use the LEFT and RIGHT buttons to select the [Reset]
menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
If [No] is selected : Settings will not be reset.
If [Yes] is selected : All print and image settings will be reset.

※ Default print setting varies depending on the printer manufacturer.
For your printer’s default setting, refer to the user’s guide that came with your printer.

■ Initialises user-changed configurations.

Reset

Exit : MENU Move: ��

No
Yes
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Setup menu

Menu tab Main menu Sub menu Secondary menu Page

Series -

Reset -

Power Save 1, 3, 5, 10 min - p.96

ENGLISH 한국어 FRANÇAIS

DEUTSCH ESPAÑOL ITALIANO

日本語

Language P”CCK»… PORTUGUÊS DUTCH p.97

DANSK SVENSKA SUOMI

BAHASA

POLSKI Magyar

No -

Yes -

05/01/01 13:00 Off

yy/mm/dd -

dd/mm/yy -

mm/dd/yy -

Off -

Imprint Date - p.98

Date&Time -

Off -

Low  -

Medium -

High -

Computer -

Printer -

File

Format

Sound

Date&Time 

p.95

p.97

p.99

p.98

USB p.99

■ In this mode, you can set up basic settings. You can use the setup menu in all camera
modes, except Voice Recording and MP3 modes.        
The items indicated by                   are default settings.
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Setup menu

※ Menus are subject to change without prior notice.

Menu tab Main menu Sub menu Secondary menu Page

Off -

On -

Dark -

LCD Normal - p.100

Bright -

NTSC -

PAL -

Quick View Off, 0.5, 1, 3 sec - p.103

No -

Yes -

Video Out

AF Lamp

Reset

p.100

p.101

p.103

■ This function allows the user to select the file naming format.

● Assigning File Names
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [File] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Series] : New files are named using numbers that follow the previous sequence, even

when a new memory card is used, or after formatting, or after deleting all
pictures. 

[Reset] : After using the reset function, the next file name will be set from 0001 even after
formatting, deleting all or inserting a new memory card.

5. Press the menu button twice and the menu will disappear.

File name

File
Power Save
Language
Format
Date&Time

Series
Reset

Setup

Back:◀ Set:OK
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File name

● The first stored folder name is 100SSCAM, and the first file name is SSM10001.
● File names are assigned sequentially from SSM10001 → SSM10002 → ~ → SSM19999.
● The folder number is assigned sequentially from 100 to 999 as follows: 

100SSCAM → 101SSCAM → ~ → 999SSCAM.
● The files used with the memory card conform to the DCF(Design rule for Camera File

systems) format.

INFORMATION

● Even if the battery and AC charger are removed and inserted again, the power off setting
will be preserved.

● Note that the automatic power off function will not operate if the camera is; in PC mode,
slide show, playing back a voice recording, playing back a movie clip or playing back an
MP3 file.

INFORMATION

Auto power off

● Setting Power Off
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Power Save] menu by pressing the 

UP/ DOWN button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[1, 3, 5, 10min] : The power will turn off automatically if not used for the period of time

specified.
5. Press the menu button twice and the menu will disappear.

■ This function switches the camera off after a set amount of time in order to prevent
unnecessary battery drainage.

File
Power Save
Language
Format
Date&Time

1 min
3 min
5 min
10 min

Setup

Back:◀ Set:OK
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Language 

● Setting Language
1. In any mode with the exception of Voice Recording and MP3

mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup] menu tab.
3. Select the [Language] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button. 
LANGUAGE sub menu : English, Korean, French, German, Spanish, Italian, S.Chinese,
T.Chinese, Japanese, Russian, Portuguese, Dutch, Danish, Swedish, Finnish, Thai,
BAHASA(MALAY/ INDONESIAN), Arabic, Hungarian, Czech and Polish.

5. Press the menu button twice and the menu will disappear.

● Formatting a Memory Card
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Format] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [No] is selected : The memory card will not be formatted. 

Press the menu button twice and the menu display will disappear. 
If [Yes] is selected : A [Processing!] message appears and the memory card will be

formatted. If you ran FORMAT in Play mode, a [No Image!] message
will appear.

■ There is a choice of languages that can be displayed on the LCD monitor. Even if the battery
and AC charger are removed and inserted again, the language setting will be preserved.

Formatting a memory card

■ This is used for formatting the memory card. If you run [Format] on the memory card, all
images and MP3 files, including the protected images, will be deleted. Be sure to download
important files to your PC before formatting the memory card.

● Be sure to run [Format] on the following types of memory card.
- A new memory card, or an unformatted memory card.
- A memory card that has a file this camera can't recognise or one that has been taken
from another camera.

● Always format the memory card using this camera. If you insert a memory card that has
been formatted using other cameras, memory card readers, or PCs, you will get a 
[Card Error!] message.

INFORMATION

File
Power Save
Language
Format
Date&Time

ENGLISH
한국어
FRANÇAIS
DEUTSCH
ESPAÑOL

Setup

Back:◀ Set:OK

File
Power Save
Language
Format
Date&Time

No
Yes

Setup

Back:◀ Set:OK
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Setting up the Date/ Time/ Date type
■ You can change the date and time that will be displayed on the captured images and set up

the date type.

● Setting Date/Time & Selecting Date Format
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Date&Time] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP, DOWN, LEFT, and RIGHT buttons to select

the desired submenu value, and then press the OK button.
RIGHT button : Selects the year/month / day/hour / minute date type.
LEFT button : Moves the cursor to the [Date&Time] main menu if the cursor is

at the first item of the date and time setup. In all other cases, the
cursor will be shifted to the left of its current position.

UP and DOWN buttons : Changes the setting value. When you select the [Off] sub menu,
the date & time will not be displayed. 

5. Press the menu button twice and the menu will disappear.

■ There is an option to include DATE/TIME on still images.

● Date Imprinting
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Imprint] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP and DOWN buttons to select the desired date

imprint type, and then press the OK button.
[Off] : The DATE & TIME will not be imprinted on the image file.
[Date] : Only the DATE will be imprinted on the image file.
[Date&Time] : The DATE & TIME will be imprinted on the image file.

5. Press the menu button twice and the menu will disappear.
※ The Date & Time are imprinted at the bottom right side of the still image.
※ The date will be imprinted as a DATE TYPE setting.
※ TIME is imprinted in the following way : [Hour : Minute] and hours are shown using the 24 hour clock.
※ The imprint function is applied only to still images except for the images taken in the [Text]

scene mode and photo frame effect mode.

Imprinting the recording date

File
Power Save
Language
Format
Date&Time

▲

05/ 05/ 01 13:01
▼

yy/mm/dd

Setup

Back:◀ Set:OK

Power Save
Language
Format
Date&Time
Imprint

Off
Date
Date&Time

Setup

Back:◀ Set:OK
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Sound 

Connecting an External Device (USB)

■ If you set the operation sound to ON, various sounds will be activated for camera startup,
when button are pressed, and if there is a card error, so that you can be aware of the camera
operation status.

● Setting Operation Sounds
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Sound] sub menu : Off/ Low/ Medium/ High

5. Press the menu button twice and the menu will disappear.

■ You can select an external device to which you want to connect the camera using the USB
cable.

● Selecting an External Device
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [USB] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Computer] : Select this if you want to connect the camera to your PC. 

Refer to page 136 for instructions on how to connect the camera to your PC.
[Printer] : Select this if you want to connect the camera to your printer. 

Refer to page 89 for instructions on how to connect the camera to your
printer.

5. Press the menu button twice and the menu will disappear.

Language
Format
Date&Time
Imprint
Sound

Off
Low
Medium
High

Setup

Back:◀ Set:OK

Format
Date&Time
Imprint
Sound
USB

Computer
Printer

Setup

Back:◀ Set:OK
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Auto Focus lamp

LCD brightness

● Adjusting LCD Brightness
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [LCD] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[LCD] sub menu : Dark, Normal, Bright

5. Press the menu button twice and the menu will disappear.

■ You can adjust the LCD brightness.

● How to set up the lamp
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [AF Lamp] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [Off] is selected : The AF lamp will not light up.
If [On] is selected : The AF lamp will light up.

※ If you select [Off] menu and take an image in poorly lit conditions or select the [Night]
scene mode, the camera may not take exact focus.

※ The Auto Focus lamp will function while using the self-timer even if the configuration is set
to off the lamp. 

■ You can turn on and off the Auto Focus lamp

Date&Time
Imprint
Sound
USB
AF Lamp

Off
On

Setup

Back:◀ Set:OK

Imprint
Sound
USB
AF Lamp
LCD

Dark
Normal
Bright

Setup

Back:◀ Set:OK
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Selecting Video out type
■ The Movie output signal from the camera can be NTSC or PAL.

Your choice of output will be governed by the type of device (monitor or TV, etc.) to which the
camera is connected. PAL mode can support only BDGHI.

● Setting the Video Out Type
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Video Out] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
- [Video Out] sub menu : NTSC, PAL

5. Press the menu button twice and the menu will disappear.

■ Connecting to an external monitor

● Using the AV cable with Cradle : Connect the camera and the cradle. 
Connect the cradle to an external monitor with the
supplied AV cable.

● Using the AV cable with Camera : Connect the camera to an external monitor with the
supplied AV cable.

Yellow - Video
White - sound

[Using the AV cable with Cradle]

[Using the AV cable with Camera]

Sound
USB
AF Lamp
LCD
Video Out

NTSC
PAL

Setup

Back:◀ Set:OK
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Selecting Video out type

● NTSC : U.S.A, Canada, Japan, South Korea, Taiwan, Mexico.
● PAL : Australia, Austria, Belgium, China, Denmark, Finland, Germany, U.K., Holland,

Italy, Kuwait, Malaysia, New Zealand, Singapore, Spain, Sweden, Switzerland,
Thailand, Norway.

● When using a TV as an external monitor, you will need to select the external or AV
channel of the TV.

● There will be a digital noise on the external monitor, but it is not a malfunction.
● If the image is not in the centre of the screen, use the TV controls to centre it.
● When the camera is connected to an external monitor, the menu will be visible on the

external monitor and the menu functions are the same as those indicated on the LCD
monitor.

INFORMATION
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Quick view
■ If you enable Quick View before capturing an image, you can view the image you just

captured on the LCD monitor for the duration set in the [Quick View] setup. Quick view is
possible only with still images.

● Setting Quick View
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Quick View] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Off] : The quick view function can’t be activated.
[0.5, 1, 3sec] : The captured image is briefly displayed during the selected time.

5. Press the menu button twice and the menu will disappear.

Initialisation

■ All camera menu and function settings will be restored to their default values. 
However, values for DATE/TIME, LANGUAGE, and VIDEO OUT will not be changed.

● Initialising the Camera
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup] menu

tab.
3. Select the [Reset] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [No] is selected : Settings will not be restored to their defaults.
If [Yes] is selected : All settings will be restored to their defaults.

USB
AF Lamp
LCD
Video Out
Quick View

Off
0.5 sec
1 sec
3 sec

Setup

Back:◀ Set:OK

AF Lamp
LCD
Video Out
Quick View
Reset

No
Yes

Setup

Back:◀ Set:OK
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Setting up the Mycam menu
■ You can set up a start up image, start up sound and shutter sound. Every camera working

mode (with the exception of Voice recording and MP3 mode) has the MyCAM menu.
The items indicated by                        are default settings.

Menu tab Main menu Sub menu Page

Off LOGO

User Image 1 User Image 2

Off Sound 1

Sound 2 Sound 3

Off Sound 1

Sound 2 Sound 3

S.Image

S.Sound

SH.Sound

p.104

p.105

p.105

■ You can select the image that is first displayed on the LCD monitor whenever the camera is
turned on.

● Setting a Startup Image
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [S.Image] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Start up image

● Use a saved image for the start-up image with the [User Image] in the [Resize] menu in
the play mode.

● The start-up image will not be deleted by deleting all images or [Format] menu.
● The User images will be deleted by [Reset] menu.

INFORMATION

※ Menus are subject to change without prior notice.

S.Image
S.Sound
SH.Sound

Mycam

Back:◀ Set:OK
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Start up sound

Shutter sound

● Setting the Startup Sound
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [S.Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

■ You can select the sound that is activated whenever the camera is turned on.

● Selecting the Shutter Sound
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [SH.Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

■ You can select the shutter sound.

● If the start up image is set to [Off], the start up sound will not acticate, even though you
may have set these to on. 

INFORMATION

S.Image
S.Sound
SH.Sound

Off
Sound1
Sound2
Sound3

Mycam

Back:◀ Set:OK

S.Image
S.Sound
SH.Sound

Off
Sound1
Sound2
Sound3

Mycam

Back:◀ Set:OK
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Downloading MP3 files

■ Digimax i50 MP3 player
This camera has an embedded MP3 player program. 
You can save the MP3 files on this camera and listen to the MP3 files that is near enough to
compact disk quality.

■ To use MP3 files, they must be saved in the internal memory or memory card of this camera. 

1. Save the desired files on your PC. 
2. Connect the camera to your PC with the USB cable and

turn on the camera. 
3. Open Window's EXPLORER and search for 

[Removable Disk]. 
4. Make MP3 folder under the Removable Disk. 
5. Select MP3 files that you want to save and copy them to

the MP3 folder. 

● Take care of the illegal duplication of MP3 files. It violates various copyright laws. 
● This camera can only play back MP3 files.
● You can make up to 100 subfolders under the MP3 folder. You can't make subdirectories

under the subfolder. 

● You can save up to 200 MP3 files in one folder. 

INFORMATION

[Incorrect directory][Correct directory]

MP3 mode
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Starting the MP3 mode

● Changing the MP3 mode : If the [Still/Movie/MP3] menu was
selected, steps from 1~4 are the same as those for selecting
the [Mode] menu
5. The mode used just before will display. 
6. Press the M (Mode) button located on the back of the

camera and  the MP3 mode will be selected. 
7. Press the Play button (                ) and an MP3 file will

play back. When an MP3 file is playing back, you can use
the earphones. 

8. Press the M (Mode) button or the Shutter button and the
camera mode will change to another mode. 

00:33/ 04:07

Sample1.mp3

■ You can select the MP3 mode by using the M (Mode) button located on the back of the
camera and through the [Mode] menu. 

● Selecting the [Mode] menu
1. Insert the battery (p.17).
2. Insert the memory card that holds MP3 files (p.20). 

As this camera has a 48MB internal memory, you can save
MP3 files on the internal memory too.  

3. Close the battery chamber cover.
4. Press the power button to turn on the camera.
5. Press the menu button and a menu will display. 

(Except for the MP3 and Voice recording mode)
6. Select the [Mode] menu by pressing the Left/ Right button. 
7. Select [Still/ Movie/ MP3] or [Full] menu by pressing the Up/ Down button. 

- [Still/ Movie/ MP3] : MP3, Still image and Movie clip modes can be selected.
- [Full] : MP3, Voice recording and All recording modes can be selected. 

8. Press the Menu button and the menu will disappear. 

Still/ Movie/ MP3
Full

[Pressing the M (Mode) button]

Mode
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Starting the MP3 mode
● Changing the MP3 mode : If the [Full] menu was selected, steps from 1-4 are the same as

those for selecting the [Mode] menu.
5. The recording mode used just before will display.
6. Press the M (Mode) button located on the back of the

camera and the mode selection menu will display.
7. To select the MP3 mode, press the Left/Right button.
8. Press the Play button (                ) and an MP3 file will play

back. To use your earphones, insert them into the
Earphones jack.

9. Press the M (Mode) button or the Shutter button and the camera mode will change to
another mode.

MP3

Set:OK/M

● If there over 100 MP3 files in the memory, it takes a little
longer for the camera to process to the MP3 mode. 

● In the MP3 mode, if there isn't an MP3 file, the 
[No Music!] message will display.

● If there is no operation during the specified time (About
30 sec.) the LCD monitor is turned off automatically
and the camera status lamp blinks. 
To use the camera, press any of the camera buttons except for the Power button.  

● The automatic power off function will not operate if the MP3 file is playing back.
● The plug for the included earphones is 3.5mm long. To buy earphones, contact your

nearest Samsung dealer or Samsung service centre. Before buying the earphones, check
the dimension of the earphones. 

INFORMATION

No Music!
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LCD monitor indicator for MP3 mode
■ The LCD monitor displays information about the MP3 file.

00:33/ 04:07

Sample1.mp3

①

③

②

④

⑤

⑥

⑦

⑧

⑨

No. Description Icons Page

1 Type of playing back p.113

2 MP3 mode -

3 Battery status p.17

4 Title of MP3 Sample1.mp3 p.110

5 Time line -

6 Playing time 00:33/ 04:07 -

7 Control button p.112

8 Volume p.112

9 Sampling rate, Bit rate -
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Using the camera buttons to adjust the camera

● MP3 lists and playback order is the same as the order for saving files on a memory card.
● If files were not encoded with correct MP3 file format, they will not list on the Playlist, even

though the files are saved with the .mp3 filename extension. 
● A title coded with unsupported language is displayed as "--------".
● This camera doesn't have a Resume function. If you turn off the camera or change the

camera mode while a file is playing back , the file may start from the first segment of the
file the next time the track is played. 

● This camera can play back an MP3 file encoded between 48 and 320Kbps bit rate. 

INFORMATION

■ You can see the MP3 files list and select a file. 

● Selecting MP3 files
1. In the MP3 mode, press the (          ) button.

The cursor will highlight a file that had been played back
at the time the list button was pressed. 

2. You can select a file by pressing the Up/ Down button.
Pressing the Left/ Right button scrolls the previous/next
page of the lists. 

Playlist button

Playlist
Ballade

Dance
TTeecchhwwiinn..mmpp33

Track05.mp3

Track01.mp3

Track02.mp3

Track03.mp3
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Using the camera buttons to adjust the camera

● Playing back the VBR (Variable Bit Rate) file
A VBR file varies the amount of output data in each time segment based on the
complexity of the input the data in that segment. 
When the VBR encoded files are played back, the LCD will display as shown. 
- The VBR icon will display instead of the the
Bit rate icon. 

- The time line isn't displayed.
- Playing time will display but the whole running
time doesn't display

INFORMATION

00:28/

Track02.mp3

VBR

00:33/ 04:07

Track01.mp3

● If the camera buttons are locked, the buttons can't be operated while playing back. 
Only the Power off, Video out, USB connection and LCD on function can be operated.

● If you press the Lock button again or turn off the camera, the camera is released. 

● If you press the Hold button for over 1 second, the
camera buttons are locked. 

● When the camera buttons are locked, an icon as
shown will display. 

Hold button
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Using the camera buttons to adjust the camera

● Before deleting MP3 files from the camera, take care to download files you want to keep
to your computer.

INFORMATION

Volume button

■ You can control the volume with this button. 

■ There are 0~30 steps. If you press it for a short time, the
volume the volume will increase or decrease with 1 step and if
you press and hold it, the volume will increase/decrease continuously.

Control button

■ When a file is playing back, press the Down button to pause
the file. Pressing it again will resume playback. 

■ You can search the MP3 files by pressing the Left/ Right button. 

Delete button

■ This deletes MP3 files stored on the memory. 

1. Press the List button and MP3 lists are displayed. 
2. Select a desired file by pressing the Up/Down/Left/Right

button and press the Delete button. 
3. A message will display as shown
4. Select a desired menu by pressing the Up/ Down button

and press the OK button. 
[Delete] : deletes the selected file.
[Cancel] : cancels "Delete files" Delete?

Delete

Cancel

Confirm : OK
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Setting up the play back function using the LCD monitor

Play mode

■ You can set various repeat and shuffle options. 
This function is adopted only in the selected folder.

1. In the MP3 mode, press the Menu button. 
2. Select the [Playlist] menu tab by pressing the Left/ Right

button. 
3. Select a desired option by pressing the Up/Down button. 

- [Play One] : plays a single track once.
- [Repeat One] : plays a single track repeatedly.
- [Play All] : plays all tracks in the folder and then stop. 
- [Repeat All] : plays all tracks in the folder repeatedly.
- [Shuffle] : randomly play all tracks in the folder.

4. Press the OK button to set the setting and the menu will disappear. 

■ MP3 mode functions can be changed by using the LCD monitor. 
In the MP3 mode, pressing the MENU button displays the menu on the LCD monitor. 
The menus you can set up in MP3 mode are as follows. 

Menu tab Main menu Sub menu Page

Play One

Repeat One

Play All

Repeat All

Shuffle

No

All

Off

On

Play mode p.113

p.114

p.114

Delete all

Slide show

※ Menus are subject to change without prior notice.

Play Mode
Play One

Repeat One
Play All

Repeat All
Shuffle
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Setting up the play back function using the LCD monitor

Slide Show

■ While the MP3 file is playing back, captured images are displaying on the LCD monitor
continuously. 
1. In the MP3 mode, press the Menu button. 
2. Select the [Slide Show] menu tab by pressing the Left/

Right button. 
3. Select a desired menu by pressing the Up/Down button and

press the OK button.
[Off] : cancels the slide show. The menu will disappear. 
[On] : Captured images are displaying continuously. 

※ When the playing back is complete, the slide show will stop. 
- Press the Pause button to pause the slide show. 
- Press the Pause button again to resume the slide show. 
- To stop the slide show, press the Pause button and then
press the Menu button twice.

Delete all

■ How to delete the files

1. In the MP3 mode, press the Menu button. 

2. Select the [Delete All] menu tab by pressing the Left/Right
button. 

3. Select a desired menu by pressing the Up/ Down button
and press the OK button. 
[No] : Cancel the "Delete files"
[All] : a confirmation window will display. 

Select the [Delete] menu and press the OK button. 
All MP3 files are deleted and a [No Music!] message
will display. 

No
All

Delete All

Exit:MENU      Move: ��

OFF
ON

Slide Show

EXIT:MENU MOVE:��

Delete?

Delete

Cancel

Confirm:OK
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Important notes
Be sure to observe the following precautions!

■ This unit contains precision electronic components. Do not use or store this unit in the
following locations.

- Areas exposed to severe changes in temperature and humidity.
- Areas exposed to dust and dirt.
- Areas exposed to direct sunlight or the inside of a vehicle in hot weather.
- Environments where there is high magnetism or excessive vibration.
- Areas with high explosives or highly flammable materials.

■ Do not leave this camera in places subject to dust, chemicals (like naphthalene and
mothball), high temperature and high humidity.
Keep this camera with silica gel in a hermetically sealed box when not planning to use the
camera for a long period of time

■ Sand can be particularly troublesome to cameras.

- Do not let sand get inside the unit when using it on beaches, coastal dunes, or other areas
where there is lots of sand.

- Doing so may result in failure or may permanently render the unit unusable.

■ Handling the camera

- Never drop the camera or subject it to severe shocks or vibrations.
- Prevent the large size LCD monitor from an impact. When this camera is not used, keep
this camera in the camera case.  

- Avoid obstructing the lens or the flash when you capture an image.
- This camera is not waterproof.
To avoid dangerous electrical shocks, never hold or operate the camera with wet hands.

- If you use this camera in wet places, such as beach or pool, do not let water or sand get
inside the camera. Doing so may result in failure or may permanently damage the unit.

■ Extremes in temperature may cause problems.

- If the camera is transferred from a cold to a warm and humid environment, condensation
can form on the delicate electronic circuitry. If this occurs, turn the camera off and wait for at
least 1 hour until all moisture is dispersed. Moisture build up can also occur in the memory
card. If this happens, turn off the camera and remove the memory card. Wait until the
moisture has dispersed.
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Important notes
■ Caution on Using the Lens

- If the lens is subjected to direct sunlight, it could result in discoloration and deterioration of
the image sensor.

- Pay attention not to get fingerprints or foreign substances on the surface of the lens.

■ If the digital camera is not used for a long period, an electric discharge can occur. 
It is a good idea to remove the batteries and the memory card if you do not intend using the
camera for an extended period of time.

■ If the camera is exposed to an electronic interference, it will turn itself off to protect the
memory card.

■ Camera Maintenance

- Use a soft brush (available from photo stores) to gently clean the lens and LCD assemblies.
If this does not work, lens-cleaning paper with lens cleaning fluid can be used.
Clean the camera body with a soft cloth. Do not allow this camera to come into contact with
solvent materials such as benzol, insecticide, thinners etc. This may damage the body shell
of the camera and also affect its performance. Rough handling can damage the LCD
monitor. Take care to avoid damage and keep the camera in its protective carry case at all
times when not in use.

■ Do not attempt to disassemble or modify the camera.

■ Under certain conditions, static electricity can cause the flash unit to fire. This is not harmful to
the camera and is not a malfunction.

■ When images are uploaded or downloaded(when the charger and USB cable are inserted
into the cradle at the same time), the data transfer may be affected by static electricity. 
In this case, disconnect and re-connect the USB cable before trying the transfer again.

■ Before an important event or going on a trip, you should check the camera condition. 

- Take a picture for testing the camera condition and prepare extra battery.
- Samsung cannot be held responsible for camera malfunctions. 

■ Do not use headphones/earphones while driving, cycling, or operating any motorized vehicle.
It may create a traffic hazard and can be illegal in some areas. 

■ Avoid using headphones/earphones at high volume. Hearing experts advise against
continuously loud and extended play. If you experience a ringing in your ears, reduce volume
or discontinue use.
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Warning indicator
■ There are several warnings that may appear on the LCD display

Card Error!

ㆍMemory card error
→ Turn off the camera power and turn it on again
→ Insert the memory card again
→ Insert the memory card and format the memory card (p.97)

Memory Error!

ㆍInternal memory error
→ Turn off the camera power and turn it on again
→ Format the memory with the memory card removed. (p.97)

No Card!

ㆍA memory card is not inserted
→ Insert a memory card

ㆍThe camera can’t recognise the memory card
→ Insert the memory card again
→ Turn off the camera power and turn it on again

Card Locked!

ㆍThe memory card is locked
→ SD memory card : Slide the write protect switch to the top of the memory card

Card Full !/ Memory Full!

ㆍThere is insufficient memory capacity to take an image
→ Insert a new memory card
→ Delete unnecessary image files to free up some memory

No Image!

ㆍThere are no images stored on the memory
→ Take images
→ Insert a memory card that is holding some images

File Error!

ㆍFile error
→ Format the memory card

ㆍMemory card error
→ Contact a camera service centre

Low Battery!

ㆍThere is low battery capacity
→ Insert charged battery
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Warning indicator
Low Light!

ㆍWhen taking pictures in dark places
→ Take pictures in Flash Photography mode.

Out Of Number

ㆍWhen selecting too many printing pages in the PictBridge menu. 
→ Select printing page within the limitation. 

Capturing!

ㆍWhen you take an image in the SF mode, Night scene and Fireworks scene modes.  
→ Do not move while the message is displaying to get a fine image. 

■ Please check the following

Before contacting a service centre

The camera doesn’t switch on

ㆍThere is low battery capacity
→ Insert charged battery (p.14 ~ 17)

ㆍBattery are inserted incorrectly with the reverse polarities
→ Insert the battery according to the polarity marks (+, -)

ㆍThe rechargeable battery is not inserted
→ Insert the battery and turn on the camera

The camera power ceases while in use

ㆍThe battery are exhausted
→ Insert charged battery

ㆍThe Camera is turned off automatically
→ Turn on the camera power again. 

Battery drain quickly

ㆍThe Camera is being used in low temperatures
→ Keep the camera in warm conditions (i.e. inside a coat or jacket) and only remove it in

order to take images
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Before contacting a service centre
Camera does not take images when pressing the Shutter button

ㆍThere is insufficient memory capacity
→ Delete unnecessary image files

ㆍThe memory card has not been formatted
→ Format the memory card (p.97)

ㆍThe memory card is exhausted
→ Insert a new memory card

ㆍThe memory card is locked
→ Refer to [Card Locked!] error message (p.117)

ㆍThe camera’s power is off
→ Turn the camera power on

ㆍThe battery are exhausted
→ Insert charged battery (p.14 ~ 17).

ㆍBattery is inserted incorrectly with the reverse polarities
→ Insert the battery according to the polarity marks (+, -)

The camera suddenly stops working while in use 

ㆍThe camera was stopped due to a malfunction
→ Remove /re-insert battery and switch the camera on

The images are unclear

ㆍA picture was taken within 0.5m from the subject without setting an appropriate macro mode
→ If the subject is closer than 0.5m, select macro shot mode

ㆍTaking a picture beyond the flash range
→ Take a picture within the flash range

ㆍThe lens is smudged or dirty
→ Clean the lens

The flash does not fire

ㆍFlash off mode has been selected
→ Dis-engage flash off mode

ㆍThe camera mode can’t use the flash
→ Refer to the FLASH instruction (p.36)

Incorrect date and time is displayed

ㆍThe date and time have been set incorrectly or the camera has adopted the default settings
→ Reset the date and time correctly
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Before contacting a service centre
The camera buttons do not operate

ㆍCamera malfunction
→ Remove /re-insert battery and switch the camera on

A card error has occurred while the memory card is in the camera.

ㆍIncorrect memory card format
→ Re-format the memory card 

The images don't play back

ㆍIncorrect file name (Violation of DCF format)
→ Do not change the image file name

Colour of image is different to the original scene 

ㆍWhite balance or effect setting is incorrect
→ Select appropriate White balance and effect

Images are too bright

ㆍExposure is excessive
→ Reset exposure compensation

No image on external monitor

ㆍThe external monitor has not been connected properly with the camera
→ Check the connection cables

ㆍThere are incorrect files in the memory card
→ Insert a memory card that has correct files

When using the PC’s explorer, the [Removable Disk] file does not show

ㆍCable connection is incorrect
→ Check the connection

ㆍThe camera is off
→ Turn the camera on

ㆍThe operating system is not Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3.
Alternatively the PC does not support USB
→ Install Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3 to PC that supports USB

ㆍThe camera driver is not installed
→ Install a [USB Storage Driver]
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Specifications
Type 1/2.5" CCD
Effective Pixel Approx. 5.0 Mega-pixel
Total Pixel Approx. 5.1 Mega-pixel
Focal Length SHD Lens f = 6.6 ~ 19.8mm (35mm film equivalent : 39 ~ 117mm)
F No. F 3.5 ~ F 4.5

Still Image mode : 1.0X ~ 5.0X  
Play mode : 1.0X ~ 10.1X (depends on image size)

LCD Monitor 2.5" color TFT LCD (230,000 pixels)
Type TTL auto focus

Normal : 50cm ~ infinity
Macro : 5cm ~ 50cm (Wide), 25cm ~ 50cm (Tele)
Super Macro : 1cm ~ 5cm (Wide)
Auto : 5cm ~ Infinity (Wide), 50cm ~ Infinity (Tele)

Type Mechanical and Electronic shutter
Speed 1 ~ 1/2,000 sec. (Night : 16 ~ 1/2,000 sec.)
Control Program AE  Metering : Multi, Spot
Compensation ±2EV (0.5EV steps)
ISO Equivalent Auto, 100, 200, 400

Auto, Auto & Red-eye reduction, Fill-in flash, Slow sync, 
Flash off

Range Wide : 0.2m ~ 2.4m,  Tele : 0.3m ~ 1.9m (ISO AUTO)
Recharging Time Approx. 4 sec.

Sharpness Soft, Normal, Vivid
Effect Normal, B&W, Sepia, Negative, Red, Green, Blue, RGB

Auto, Daylight, Cloudy, Fluorescent_H, Fluorescent_L,
Tungsten, Custom 
Voice Recording (max. 1 hour) 
Voice Memo in Still Image (max. 10 sec.)

Date Imprinting Off, Date, Date&Time (user selectable)
Modes : Auto, Manual, Scene, SF
* Scene : Night, Portrait, Children, Landscape, Text, Close-up,

Sunset, Dawn, Backlight, Fireworks, Beach & Snow
Continuous : Single, Continuous
Self-timer : 2 sec., 10 sec., Double(10 sec., 2 sec.) 
With Audio or without Audio (user selectable, recording time :
memory capacity dependent)
Size : 640x480, 320x240, 160x128 (3X Optical Zoom, Mute during Zoom Operation)
Frame rate : 30 fps, 15 fps
Movie Stabilizer (User Selectable)
Movie Editing (Embeded) : Pause during recording, Still Image

Capture, Time Trimming

Lens

Range

Digital Zoom

Focusing

Image Sensor

Shutter

Exposure

White Balance

Flash
Modes

Voice Recording

Shooting

Still Image

Movie Clip
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Specifications
Internal memory : Approx. 48MB flash memory
External memory : SD card /MMC (Up to 1GB Guaranteed)
* Internal memory is subject to change without prior notice.
Still Image : JPEG (DCF), EXIF 2.2, DPOF 1.1, PictBridge 1.0 
Movie Clip : AVI (MPEG-4) Audio : WAV
5M : 2592x1944     4M : 2272x1704
3M : 2048x1536     2M : 1600x1200 
1M : 1024x768    VGA : 640x480 
5M  : Super Fine 11,  Fine 21,  Normal 32 
4M  : Super Fine 14,  Fine 27,  Normal 40
3M  : Super Fine 17,  Fine 33,  Normal 49
2M  : Super Fine 28,  Fine 52,  Normal 75
1M  : Super Fine 66,  Fine 111,  Normal 151
VGA : Super Fine 149,  Fine 217,  Normal 275
* These figures are measured under Samsung’s standard

conditions and may vary depending on shooting conditions,
camera settings and memory card type.

Type Single image, Thumbnails, Slide show, Movie Clip, Album 
Editing Trimming, Resizing, Rotate, Effect

Digital output connector : USB 2.0 Audio : Mono
Video output : NTSC, PAL (user selectable)
DC power input connector : 4.2V
Rechargeable battery : 3.7V Li-ion battery (SLB-0737) 
AC Charger : DC 4.2V, 450mA/ 760mA (SAC-41)
* Included battery may vary depending on sales region. 
92.3 x 60.2 x 17.7 mm
(excluding the projecting parts of the camera)

Weight Approx. 120g (without battery and card)
Operating Temperature 0 ~ 40 ˚C
Operating Humidity 5 ~ 85 %

Storage Driver (Windows98/98SE/2000/ME/XP, 
Mac OS 9.2 ~ 10.3)

Application Digimax Master, Digimax Reader 
SF (Safety Flash), MP3 Player function
3X Optical Zoom for Still & Movie.
New Charging System (Cradle (Optional))
MPEG-4 VGA 30fps Movie Clip (supporting Edit on DSC)
Powerful Effect (Colour, Highlight, Composite, Frame)
Quick Mode Change (M button, SF Button)

Capacity
(32MB)

Image Size

Storage

Interface

Image Play

Dimensions (WxHxD)

Power Source

Software

Special Features

Camera Driver

File Format

Media
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Specifications

※ Specifications are subject to change without prior notice.
※ All trademarks are the property of their respective owners.

Frequency 20Hz~20KHz
Earphone Port 3.5mm Port (Stereo Type)
Output Maximum Volume  Left 15mW + Right 15mW(16Ω)
Noise Ratio 85 dB with 20 KHz LPF
File Format MP3 (MPEG-1/2/2.5 Layer 3)
Bit Rate 48 ~ 320kbps (Including VBR)

One, All, Repeat One, Repeat All, Random, Slide Show On/Off
(User Selectable)

File

Play Mode

Audio

※ MP3 player
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Software Notes
Please ensure that you read the instruction manual carefully before use.
ㆍThe attached software is a camera driver and image editing software tool for Windows.
ㆍUnder no circumstances should all or part of either the software or the user manual be

reproduced.
ㆍCopyrights for software are licensed only for use with a camera.
ㆍIn the unlikely event of a manufacturing fault, we will repair or exchange your camera. 

We cannot, however, be held responsible in any way for damage caused by inappropriate use.
ㆍUsing a Hand-made PC or a PC and OS that has not been guaranteed by the manufacturer is

not covered by the Samsung warranty.
ㆍBefore reading this manual, you should have a basic knowledge of computers and O/S

(Operating Systems).

System Requirements

For Windows For Macintosh

Power Mac G3 or later

Windows 98/98SE/2000/ME/XP Mac OS 9.2 ~ 10.3

Minimum 64MB RAM (XP : 128MB) Minimum 64MB RAM

200MB of available hard disk space 110MB of available hard-disk space

(1GB recommended)

USB port USB port

CD-ROM drive CD-ROM drive

QuickTime player or a media player that

supports AVI file format

DivX(for movie clip)

PC with processor better than Pentium II

450Mz (Pentium 700MHz recommended)

1024x768 pixels, 16-bit colour display

compatible monitor (24-bit colour display

recommended)
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About the software
After inserting the CD-ROM provided with this camera into the CD-ROM drive, the following
window should automatically run.

Before connecting the camera to the PC, you
should first install the camera driver.

■ Camera driver : This enables images to transfer between the camera and PC.
This camera uses the USB Storage Driver as the camera driver. You can use the camera as
a USB card reader. After installing the driver and connecting this camera to the PC, you can
find [Removable Disk] in [Windows Explorer] or [My computer]. A USB Storage Driver is
provided only for Windows. A USB Driver for MAC is not included with the Application CD.
You can use the camera with Mac OS 9.2 ~ 10.3.

■ XviD codec : This makes movie clips(MPEG-4) recorded with this camera play back on
a PC. 

To play back a movie clip recorded with this camera, you must install the XviD codec. 
If a movie clip recorded with this camera does not play well, install this codec. 
This software is only compatible with Windows. 
If a movie clip can’t play back on the Mac OS, please visit the following site.
http://www.divx.com/divx/mac/
If a movie clip can’t play back on the Mac OS, use a media player that supports XviD codec
(Mplayer, VideoLanClient) 

■ Digimax Master : This is the all-in-on multi media software solution. (p.144)
You can download, view, edit and save your digital images and movie clips clip with this
software. This software is only compatible with Windows.
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About the software
■ Digimax Reader : Text recognition program. (p.150)

You can save an image file that was captured in the TEXT mode as a text file with this
program. This software is only compatible with Windows.

● Be sure to check the system requirements before installing the driver.
● You should allow 5 ~ 10 seconds for running the automatic setup program according to

the capability of your computer. If the frame does not show, run the [Windows Explorer]
and select [Samsung.exe] in the CD-ROM Drive root directory.

INFORMATION
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Setting up the application software
To use this camera with a PC, install the application software first.
After this has been done, the stored images in the camera can be moved to the PC and can be
edited by an image editing program.

You can visit the Samsung web-site through the internet.

http://www.samsungcamera.com : English
http://www.samsungcamera.co.kr : Korean

1. Click the [Install] menu in the Auto run frame.
The camera driver is installed automatically.

● Close other programs before installing the application software.
● Before installing the application software, disconnect the USB connection.

INFORMATION

2. Installation is complete.
Click the [Finish] button.

3. The Software License Agreement window for
DirectX will be displayed. If you agree to this,
select [I accept the agreement] and click [Next >]
button. the window will then move to the next step.
If you disagree, select [I do not accept the
agreement] and click [Cancel] button.
The installation program will be cancelled.

[Click !]

[Click !]

[Click !]
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Setting up the application software
4. A window will open. Click the [Next(N) >] button.

5. DirectX Installation is completed.
Click the [Finish] button and then the Xvid
codec installation will be started.
* The system will not reboot even if you click

the [Finish] button.
* The screen shot of step 5 can be different

from the illustration depending on the system
requirements.

[Click !]

[Click !]

6. A windows to check whether the PC has XviD codec or not
will display.  
[Preview] : You can check the movie clip display

condition. 
[Install] : The XviD codec is installed. 
[Cancel] : The XviD codec is not installed and a window

for installing the application softwares will
display.

※ If you didn’t click the [Preview] button, the [Install] button can’t be selected. 

[Click !]
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Setting up the application software

9. The Software License Agreement window will be
displayed. If you agree to this, select [I accept the
agreement] and click [Next >] button. 
The window will then move to the next step. 
If you disagree, select [I do not accept the agreement]
and click [Cancel] button. The installation program will
be cancelled.

※ The XviD codec is distributed according to the GNU
General Public License and everyone can copy,
distribute and change this codec. For more information, see the License documents. 

[Click !]

7. If an error listed below takes place during the preview,
click the [Install] button to install the XviD codec. 

- Only a voice plays back. 
- An error message displays and the movie clip does not
play back.

* A window shown alongside may display according
to the system requirements.

8. The XviD codec installation window will be displayed
as shown alongside. Click the [Next >] button. 

[Click !]

[Click !]
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Setting up the application software
10. The XviD information window will display. 

Click the [Next >] button. 

11. The destination selection window will open. 
Click [Next >] button.
To copy to the files to another folder, click [Browse...]
and choose a folder you want.

[Click !]

[Click !]

13. The [Select Additional Tasks] window will display. 
Select the additional tasks and click the [Next >] button. 

12. A window will open, asking you to choose a folder to
which program icons will be added. 
Click [Next >] button. 
If you want to add the program icons to a different folder,
choose another folder, and then click [Next >] button.

[Click !]

[Click !]



《131》

Setting up the application software
14. The XviD codec is ready to install. 

Click the [Install] button.

[Click !]

15. Installation is complete.
Click the [Finish] button.

[Click !]

● If you select [Exit] at step 16, the application program installation will be cancelled.

INFORMATION 

16. A window where you can choose the program you want
to install will appear. Click [Install]. 
For information on application software, please refer to
page 125, 126.

[Click !]

17. The Digimax Master installation window will be displayed
as shown alongside. Click the [Next >] button.

[Click !]
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Setting up the application software

18. A window will open. Click the [Next >] button.

19. A destination selection window will open. Click [Next >].
To copy the files to another folder, click [Browse..]
and choose a folder you want.

21. Click [Install(I)] button and Digimax Master starts installing.

20. A window will open, asking you to choose a folder to
which program icons will be added. Click [Next >] button.
If you want to choose another folder, click [Browse..] and
choose a folder you want.

● If you select [Cancel] at step 17, a window for installing Digimax Reader will be displayed.

INFORMATION

[Click !]

[Click !]

[Click !]

[Click !]
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Setting up the application software

23. A window will be displayed as shown alongside.
Click the [INSTALL] button.
- If you click the [Manual] button, instructions for using
Digimax reader will be displayed.

- Click the [EXIT] button and the Digimax reader
installation will be cancelled and a window for
restarting the computer will appear.

24. A window will open. Click the [Next >] button.

[Click !]

25. The Software License Agreement window will be
displayed. If you agree to this, click [Yes],
the window will then move to the next step.
If you disagree, click [No] and the installation program
will be cancelled.

22. Digimax Master installation is successfully completed.
Click the [Finish] button to install Digimax Reader.
* The screen shot of step 22 can be different from the

illustration depending on the system requirements.

[Click !]

[Click !]

[Click !]



《134》

Setting up the application software
26. A destination selection window will open.

Click the [Next >] button.
To copy the files to another folder, click
[Browse...] and choose a folder you want.

[Click !]

27. Digimax Reader Installation is completed.
The system will not reboot even if the [Yes, I
want to restart the computer now] option is
selected.

※ The screen shot of step 27 can be different
from the illustration depending on the system
requirements.

28. To apply changes, you must restart the computer.
Select [Yes, I want to restart my computer now], and
then click the [OK] button. 

29. After restarting the computer, connect the PC to the camera with the USB cable.(p.136)

30. Turn the camera power on.
The [Found New Hardware Wizard] will open and 
the computer will recognise the camera.
* If your OS is Windows XP, an image viewer

program will open.
If the download window of Digmax Master opens
after starting Digimax Master, the camera driver was
setup successfully.

[Click !]

[Click !]
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Setting up the application software

● If you have installed the camera driver, The [Found New Hardware Wizard] may not
open.

● On a Windows 98 or 98 SE system, the Found New Hardware Wizard dialog box opens
and a window asking you to select a driver file may appear. In this case, specify "USB
Driver" in the CD supplied. (for Windows 98 and 98 SE).

● Before connecting the camera to the PC, You should first install the camera driver.
● After installing the camera driver, you have to restart your PC.
● If you connect the camera to the PC before installing the camera driver, the [Found New

Hardware Wizard] will open.
In this case, cancel the [Found New Hardware Wizard] and disconnect the camera.
Install the camera driver and connect the camera to the PC again.

● Should the computer not find the camera driver after installation, please try one or more of
the following measures.
1. Delete the camera driver (p.139), and re-install the driver.
2. Refer to FAQ (p.152) to check for a possible solution to the problem.
3. If your PC’s central processing unit is VIA chip (This is shown in the USB Host

Controller), download the patch file from the Samsung Camera web page.
(http://www.samsungcamera.com)

INFORMATION

31. If you can see [Removable Disk] under [My computer],
the camera driver installation was successful.
Now you can transfer image files from the camera to
PC via the USB cable.
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Starting PC mode

■ Connecting the camera to a PC
1. In any mode with the exception of Voice Recording and

MP3 mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [USB] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP and DOWN buttons to select [Computer],

and then press the OK button.

[Using the USB cable with Cradle]

[Using the USB cable with Camera]

※ If you selected [Printer] in Step 4, when you connect the camera to your printer, the
[Connecting Printer] message will display and the connection will not be established.
In this case, disconnect the USB cable, and then follow the procedure from Step 2 and
onward.

• If you connect the USB cable to a USB port on your PC and then turn on the power, the
camera will automatically switch to "computer connection mode".

• In this mode, you can download stored images to your PC through the USB cable.

Format
Date&Time
Imprint
Sound
USB

Computer
Printer

Setup

Back:◀ Set:OK
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Starting PC mode

3. Select an image and press the right mouse button.

4. A pop-up menu will open.
Click the [Cut] or [Copy] menu.
- [Cut] : cuts a selected file.
- [Copy] : copies files.

■ Downloading stored images
You can download the still images stored on the camera to your PC's hard disk and print
them or use a photo editing software to edit them.

1. Connect the camera to your PC with the USB cable.

2. On your computer's desktop display, select
[My computer] and double click [Removable Disk
→ DCIM → 100SSCAM].
The image files will then be displayed.

5. Click a folder where you want to paste the file.
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Starting PC mode
6. Press the right mouse button and a pop-up menu

will open. Click [Paste].

7. An image file is transferred from the camera to
your PC.

- By using [Digimax Master], you can see the stored images in the memory directly on the
PC monitor and you can copy or move the image files.
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Removing the USB Driver for Windows 98SE
■ To remove the USB driver, refer to the process shown below.

1. Click [Start → Settings] and click [Control Panel].

4. Click the [OK] button.
The camera is removed from the system.

2. Double-click [System].

3. Select [Device manager → Hard Disk Controller →
Samsung Digital Camera] and click the [Delete]
button.

[Click !]
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Removing the USB Driver for Windows 98SE
5. Click [Start → Settings → Control Panel] and

double click [Add/Remove programs].

6. The [Add/Remove Programs Properties] window
will open. Click [Digimax i50 MP3] and click the
[Add/Remove] button.

7. Uninstallation is complete. Click the [Finish] button
and the window will disappear.

[Click !]

[Click !]
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Removable Disk
■ To use this camera as a Removable Disk, install (p.127) the USB Driver.

1. Before turning the camera power on, connect the camera to the PC with the USB cable.

2. Click [Removable Disk] under [My computer] or [Windows Explorer].

3. Image files stored in the Removable Disk (DCIM → 100SSCAM) can be transferred to the
PC.

Important information whilst using the Removable Disk
● The [Removable Disk] indicator will not show when the camera power is off or the USB

cable is removed.
● We recommend that you should copy the images to the PC to view them. Opening

images directly from the removable disk may be subject to unexpected disconnection.
● When uploading images from the PC to the camera, ensure that the uploaded file names

are not the same as those already stored on the memory. 
● When you upload a file that is not taken by this camera to the Removable Disk, the [File

Error!] message will be displayed on the LCD monitor in the PLAY mode, and nothing is
displayed in THUMBNAIL mode.

● The camera status lamp will blink, when a file is
transferred (copy or deletion) between the PC and
the camera. Do not remove the USB cable until the
lamp stops blinking. 
To remove the USB cable in Windows
2000/ME/XP, use the [Unplug or Eject Hardware]
icon on the task bar.

INFORMATION
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Removing the removable disk

[Click !]

[Double-click!]

[Click !]

[Click !]

2. Double-click the [Unplug or Eject Hardware] icon
on the task bar.

■ Windows 2000/ME/XP
(The illustrations may be different from the real display in accordance with the Windows O/S.)

1. Check whether the camera and PC are transferring a file. 
If the camera status lamp blinks, you have to wait until the lamp illuminates.

■ Windows 98SE

1. Check whether the camera and PC are transferring a file. 
If the camera status lamp blinks, you have to wait until the lamp illuminates.

2. Unplug the USB cable.

3. The [Unplug or Eject Hardware] window will
open. Select the [USB Mass Storage Device]
and click the [Stop] button.

4. The [Stop a Hardware device] window will open.
Select the [USB Mass Storage Device] and click
the [OK] button.

5. A [Safe to Remove Hardware] window will
open. Click the [OK] button.
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Removing the removable disk

1. A USB Driver for MAC is not included with the software CD as MAC OS supports the
camera driver.

2. Check the MAC OS. You can check the MAC OS version during MAC OS start-up. 
This camera is compatible with MAC OS 9.2 ~ 10.3.

3. Connect the camera to the Macintosh and turn the camera power on.
4. A new icon will be displayed on the desktop after connecting the camera to the MAC.

Using the USB Driver for MAC

Setting up the USB Driver for MAC

1. Double click a new icon on the desktop and the folder in the memory will be displayed.
2. Select an image file and copy or move it to MAC.

● For Mac OS 10.0 or later : First complete uploading from computer to camera and then
remove the removable disk with the Extract command.

●If a movie clip can’t play back on the Mac OS, please visit the following
site(http://www.divx.com/divx/mac/) and download the codec. Or, use a media player that
supports the Xvid codec (Mplayer, VLC(VideoLAN Client) media player).

CAUTION

6. A [Unplug or Eject Hardware] window will open.
Click the [Close] button and the removable disk
will be removed safely.

7. Unplug the USB cable.

[Click !]
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Digimax Master
■ You can download, view, edit and save your images and movies with this software. This

software is only compatible with Windows except for the Windows 98.

■ To start the program, click [Start → Programs → Samsung → Digimax Master].

● Downloading images
1. Connect the camera to your PC.

2. A window for downloading images will display after
connecting the camera and your PC.
- To download the captured images, select the
[Select All(A)] button.

- Select desired folder in the window and click the
[Select All(A)] button. You can save captured
images and selected folder.

- If you click the [Cancel] button, downloading will be
cancelled.

3. Click [Next(N) >] button.

[Click !]

[Click !]
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Digimax Master

7. Downloaded images will be displayed.

4. Select a destination and make a folder to save
downloaded images and folders.
- Folder names can be made in order of date and
images will be downloaded.

- Folder name will be made as you want and images
will be downloaded.

- After selecting a folder that was made before,
images will be downloaded.

5. Click [Next(N) >] button.

6. A window will open as shown alongside.
The destination of the selected folder will be
displayed on the upper side of the window.
Click the [Start] button to download the images.

[Click !]

[Click !]
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Digimax Master
● Image viewer : You can view the stored images.

- Image viewer functions are listed below.
① Menu bar : You can select menus.

File, Edit, View, Tools, Change functions, Auto download, help, etc.
② Image selection window : You can select the desired images in this window.
③ Media type selection menu : You can select image viewer, image edit and movie edit

functions in this menu.
④ Preview window : You can preview a image or a movie clip and check the multi media

information.
⑤ Zoom bar : You can change preview size.
⑥ Folder display window : You can see the folder location of the selected image.
⑦ Image display window : Images of the selected folder are displayed.

※ Refer to the [Help] menu in Digimax Master for further information.

① ⑤
⑥

⑦

②

③

④
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Digimax Master
● Image edit : You can edit the still image.

- Image edit functions are listed below.
① Edit menu : You can select the following menus.

[Tools] : You can resize or crop the selected image. See the [Help] menu.
[Adjust] : You can modify image quality. See the [Help] menu.
[Retouch] : You can change image or insert effects on the image. See the [Help] menu.

② Drawing tools : Tools for editing an image.
③ Image display window : a selected image displays in this window.
④ Preview window : You can preview the changed image.

※ A still image edited with Digimax Master can’t be played back on the camera.
※ Refer to the [Help] menu in Digimax Master for further information.

①

②

③

④
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Digimax Master
● Movie edit : You can get the still image, movie clip, narration, music files together in a movie clip.

- Movie clip edit functions are listed below.
① Edit menu : You can select the following menus.

[Add Media] : You can add other media elements to a movie.
[Edit Clip] : You can change the brightness, contrast, colour and saturation.
[Effects] : You can insert an effect.
[Set Text] : You can insert texts.
[Narrate] : You can insert a narration.
[Produce] : You can save the edited multi media as a new file name.

Frame display window : You can insert multi media in this window. You can
select AVI, Windows media (wmv), Windows media (asf) and movie clip for
this camera (avi, MPEG-4) file types.

② Frame display window : You can insert multi media in this window.

※ Some movie clips that was compressed with a codec that is not compatible with the Digimax
Master can’t play back in the Digimax Master.

※ Refer to the [Help] menu in Digimax Master for further information.

①

②
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Digimax Master
ㆍMovies for viewing on the camera : You can play back a movie on this camera

1. Select a movie for playing back on the camera by pressing the [Add] button. 
Insert effects and edit the movie. To save the edited movie, press the [Make] button. 

2. Select [Movie for camera] video type. 

3. Select Camera option, Output location, File name and press the [Make] button. 
- Frame size : Selecting the width and height of the frame. 
- Frame rate : Selecting the frame rate per second. 
- File location : Selecting a location where the edited movie is saved. 
- File name : To play back the movie on the camera, you must keep the DCF rule. Save

the movie as SSM1XXXX.avi (You can input any numbers between 0001
~ 9999 instead of XXXX letters). 

4. Connect the camera to the computer with the
included USB cable. 

5. Copy the edited movie to [Removable
Disk\DCIM\XXXSSCAM]. 
(You can input any numbers between 100 ~ 999
instead of XXX letters)

6. You can play back the movie in the Play mode of the
camera. 
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Digimax Reader
■ Digimax Reader is a Text recognition program. You can save an image file that is captured in

the Text mode, as a text file with this program. This software is only compatible with Windows.

■ To start the program, click [Start → Programs → Digimax Reader Eng].
The following screen will appear.

■ How to use the Digimax Reader
1. Connect the camera and the PC with a USB cable and download the images that were

stored in the camera to the PC.
* Please see page 136 ~ 138 for details on Connecting a camera and PC, Downloading

images.

2. Run the Digimax Reader.

3. Click the Open(        ) icon as shown alongside.

4. Select the image you want to save as a text file.
* Only an image that was taken with a SAMSUNG

camera can be opened.
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Digimax Reader
5. Click the Area Analysis(        ) icon to scan the image.

6. Part of the image you selected will be displayed as
shown.

7. Click the Character Recognition(        ) icon.
The part selected in the previous step will be
recognized as text.

8. To save the section as a text, click the Save(         )
icon. A window as shown alongside will be displayed.

● To get an image that can be recognised as a text : 
- Keep a distance that you can capture the image clearly between the subject and the camera.
- The subject needs to be centered.
- Seek to avoid camera shake to get a good image.

● Refer to the [Help] menu in Digimax Reader for further information.

INFORMATION 

9. Select the file type that you want.
Selectable file types : *.TXT, *.HWP, *.DOC, *.RTF
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FAQ
■ Please check the following if the USB connection malfunctions.

[Case 1] The camera power is off.
→ Turn the camera power on.

[Case 2] USB Driver is not installed correctly.
→ Install the USB Driver correctly. Refer to page 127.

[Case 3] The USB cable is not connected or you are using a cable with an incorrect
specification.

→ Use a USB cable with the correct specification.

[Case 4] The camera is not recognized by your PC. 
Sometimes, the camera may appear under [Unknown Devices] in Device
Manager.

→ Install the camera driver correctly.
Turn off the camera, remove the USB cable, plug in the USB cable again, and
then turn on the camera.

[Case 5] There is an unexpected error during file transfer
→ Turn the camera power off and on again. Transfer the file again.

[Case 6] How do I know my computer supports a USB Interface?
→ Check the USB port in your computer or keyboard.
→ Check the OS version. A USB Interface is available in Windows 98, 98SE, 2000,

ME .XP.
→ Check [Universal Serial Bus controllers] in Device Manager. Carry out the

following checks [Universal Serial Bus controllers].
Win 98/ME : Follow [Start → Settings → Control Panel → System → Device

Manager  → Universal Serial Bus controllers].
Win 2000 : Follow [Start → Settings → Control Panel → System → Hardware

→ Device Manager → Universal Serial Bus controllers].
Win XP : Follow [Start → Control Panel → Performance and Maintenance →

System → Hardware → Device Manager → Universal Serial Bus
controllers].



《153》

FAQ
There must be USB Host Controller and USB root hub under [Universal Serial
Bus controllers].
In addition, double-click on the USB Universal Host Controller and the USB Root
Hub to check if the Device Status states "This device is working properly". 
If the Device Status says the device is "not working properly", click the "Driver" tab
and then click [Update Driver] or [Reinstall Driver].

→ When all the conditions mentioned above are met, the computer can support the
USB interface.

[Case 7] When using the USB hub.
→ There may be a problem in connecting the camera to the PC through the USB

hub if the PC and the hub are not compatible. Wherever possible, connect the
camera to the PC directly.

[Case 8] Are other USB cables connected to the PC?
→ The camera may malfunction when it is connected to the PC at the same time as

another USB cable.  In this case, disconnect the other USB cable, and connect
only one USB cable to the camera.

[Case 9] When I open the Device Manager (by clicking Start → (Settings) → Control Panel
→ (Performance and Maintenance) → System → (Hardware) → Device
Manager), there are  「Unknown Devices」or  「Other Devices」entries with a
yellow question mark(?) beside them or devices with an exclamation mark(!)
beside them.

→ Right-click on the entry with the question(?) or exclamation (!) mark and select
"Remove". Restart the PC and connect the camera the again. For Windows 98
PC, remove the camera driver also, restart the PC, and then reinstall the camera
driver.

→ Double-click on the entry with the question (?) or exclamation (!) mark, click the
"Driver" tab, and click [Update Driver] or [Reinstall Driver]. If a message appears
asking you to specify the location of the appropriate device driver, specify "USB
Driver" in the CD supplied.

[Case 10] In some security programs (Norton Anti Virus, V3, etc.), the computer may not
recognize the camera as a removable disk. 

→ Stop the security programs and connect the camera to the computer. Refer to the
security program instructions about how to stop the program. 
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FAQ
■ When the movie clip doesn’t play back on the PC

※ When the movie clip recorded by the camera doesn’t play back on the PC, the causes are
mostly due to the codec installed on the PC.

● When codec for play back the movie clip isn’t installed
→ Install the codec as listed below. 

[Installing codec for Windows]
1) Insert the CD provided with the camera 
2) Run the windows explorer and select [CD-ROM drive:\XviD] folder and click the XviD

codex-1[1].1.0.exe file. 

[Installing codec for Mac OS]
1) Visit the following site for downloading the codec.http://www.divx.com/divx/mac
2) Click the [Free Download] button located at the upper right side of the page and a window

for downloading the DivX codec will display. 
3) Select Mac OS you use and click the [Download] button. Save it on a folder you want to. 
4) Run the downloaded file and the codec for playing back the movie clip will be installed.
※ If a movie clip can’t play back on the Mac OS, use a media player that supports XviD

codec (Mplayer, VideoLanClient). 

● When the DirectX 9.0 or later is not installed
→ Install the DirectX 9.0 or later
1) Insert the CD provided with the camera
2) Run the windows explorer and select the [CD-ROM drive:\ USB Driver\DirectX 9.0] folder

and click the DXESETUP.exe file.The DirectX will be installed. Visit the following site for
downloading the DirectX.http://www.microsoft.com/directx
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FAQ
● If a PC (Windows 98) stops responding while the camera and PC are connected repeatedly

→ If a PC (Windows 98) is turned on for a long time and the camera is connected repeatedly,
the PC may not recognise the camera. In this case, re-start the PC. 

● If a PC connected with the camera stops responding while Windows is starting. 
→ In this case, disconnect the PC and the camera and Windows will start.

If the problem happens continuously, set the Legacy USB Support to disable and re-start
the PC. The Legacy USB Support is in the BIOS setup menu. (The BIOS setup menu
differs from the PC manufacturers and some BIOS menus don’t have Legacy USB
Support) If you can’t change the menu by yourself, contact to the PC manufacturer or
BIOS manufacturer. 

● If the movie clip can’t be deleted, removable disk can’t be extracted or an error message
displays during the file transfer.  
→ If you install only the Digimax Master, the problems mentioned above occasionally

happen. 
- Close the Digimax Master program by clicking the Digimax Viewer icon on the Taskbar.
- Install all the application programs included in the software CD. 
(You must install the Movie clip codec)
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